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Update 
The Music Studio 3.0 

for Tandy, IBM and other MS-DOS computers 

This Update serves to clarify and correct certain information 
provided in the user’s guide. Tandy lOOOSL owners, be sure to 
read the section titled “Note to Tandy 1OOOSL Owners.” All other 
users should read the information contained in the sections “Addi- 
tional Information” and “Corrections.” 

NOTE TO TANDY lOOOSL OWNERS 
512K of memory is recommended for full featured use of The Music Studio 3.0. If 
you wish to operate with 384K RAM, follow the steps listed below: 

1. Be sure your system configuration contains no loadable drivers not supported by 
DeskMate; i.e., mouse devices or joystick drivers. These require extra memory 
which will take away functionality of The Music Studio 3.0. 

2. Load DeskMate from the D: drive. Always use the version of DeskMate resident 
in ROM and accessable through drive D @:). Do not use the runtime version 
sumlied with The Music Studio 3.0. 

3. Insert the Music Studio 3.0 program disk into drive A .  

4. From the DeskMate directory menu, select Change Directory. 

5. Type A:\ into the directory dhlog box and press Return. 

6. From the DeskMate Program List Box, double click on MSTUDIO.PDM to start 
The Music Studio 3.0 program. 

7. You’re now ready to begin the Guided Tour in the user’s guide starting on page 17. 

NOTE: If you’re using a display or printer device that is not supported by the 
DeskMate drivers-- for example, an EGA or VGA video display card--you’ll get the 
following message: 

Unable to locate file ‘XXX.RES’. 
Press Enter to search the entire system, or E x  to cancel... 
cO>K, cC>ancel... 



Press C to cancel and follow the steps below to use the dnvers supplied with The 
Music Studio 3.0. 

You'll need to copy the runtime drivers fmm the DeskMate Runtime disk onto 
another floppy or your hard disk. However, the lOOOSL version of DeskMate does not 
recognize the f ie  extension of the runtime drivers. Before runniig DeskMate from 
the D: drive, insert the DeskMate Runtime disk into drive A .  At the A: prompt, type 
in one of these commands: 

If you're using a floppy disk (have a formatted disk on hand) use this command: 
Copy A:*.RRS B:*.RES 

If you're using a hard drive, you can copy the extensions to the C: drive using this 
command: 
Copy A:*.RRS C:*.RES 

Now you're ready to load DeskMate and The Music Studio 3.0 as described in steps 1 
through 7 above. 

ADDITIONAL INFORMATION FOR ALL USERS 
Song Scroll Bar (page 45) 
Using the keyboard arrows allows you to scroll the separate staves of a song indeped- 
ant of one another. The scroll arrows at the bottom left and right of your screen scroll 
the staves in unison. 

Column Numbers (pages 45-46) 
A repeat symbol, inserted volume, inserted tempo, and inserted measure bar are all 
assigned a column number; therefore, the length of a song (in columns) will increase 
if any of these items are added. 

MIDI Record - Metronome (pages 36,78) 
When using the metronome for recording from an attached MIDI instrument, a note 
recorded on the metronome beat will always be displayed as a quarter note. Even if 
the time signature is set to 2/2, you must play one note for two metronome beats to 
get for example, a half note. 

NOTE: Notes performed legato (with no time space between notes or overlapping 
start times) during a MIDI record are displayed with a rest placed over each note 
value. 

Open Style (page 55) 
If you have a song with one staff and you open a style that is saved with more than 
one staff, the extra staves will be added to your song. However, if a style that you 
open has fewer staves than your current song, the number of staves will remain the 



same. 

Print (page 56) 
When you print a song with multiple staves that includes inserted and numbered 
measures, only the first staff will be printed with measure numbers. 

Select Instruments (page 62) 
If digitized sounds are selected from the Option Menu, the instrument names will 
change to reflect the names of the three digitized sounds and will not be saved. It’s a 
good idea to save a style file with all 15 instrument names so you can use those names 
when the digitized sounds are turned off. 

Note Filters 
Edit Filters - Range boxes (page 67) 
The range of the Edit Filter is from A0 to G8. 

Delete Filter (page 68) 
Using the Edit Filter to delete notes or instruments in a long song can take up to 
several hours to complete. When using this command, it’s best to work on small 
edit blocks so the operation time can be reduced. 

Duration Filter (page 69) 
Applying the Edit Filter quantization on a marked block will change the duration 
of filtered notes but will not change the start time of filtered notes. 

Design Sounds - Frequency Box (page 71) 
The frequency box will accept only numbers between four and 4400, 

MIDI Settings - Presets (page 76-77) 
The Music Studio 3.0 allows for preset numbers 1 - 127. If your MIDI keyboard 
begins at preset 00, preset number 01 on The Music Studio 3.0 will address that 
setting and all subsequent numbers will be off by one. 

MIDI Settings - Assigning Instruments (page 77) 
If you enter S in the volume settings, the song will play at the volume associated with 
each note; i.e., a song recorded from a volume-sensitive keyboard or notes pasted 
with changes in the volume slider. This is useful when preserving the volume 
information of a MIDI recording and when note volumes are changed using the filter. 

NOTE: If a section of music is pasted into a song and the MIDI volume setting is set 
to S, the notes will be performed at the volumes of the original song and not at the 
volume of the target song. 

If you enter V in the volume settings, the song will play back using the volume 
slider setting, inserted volume changes, and crescendo/diminuendo notation. 



Notation Menu - CrescendolDiminuendo (page 82) 
A crescendo or diminuendo can only be heard if a song is played with the MIDI 
option and the MIDI keyboard and preset are velocity sensitive. 

Auto-Znsert Measures (page 84) 
When editing a song that has measure bars auto-inserted, you must select the Auto- 
Insert Measures command after making an editing change in order for the measures to 
be recalculated and accurately displayed. 

Slur (page 84) 
Notes that are slurred will delete a staccato or accent marking. 

Tie (page 84) 
With digitized sounds, only the first tied note will play, followed by silence for the 
remaining duration. 

Znit Files 
When The Music Studio 3.0 loads, it looks for init files for default settings. You can 
create these files directly: 

INITSND - Save a sound file as 1NIT.SND in the Design Sound dialog box. 
This will be the default sound whenever The Music Studio 3.0 cannot find a 
digitized sound. 

INITOSTY - Save a style file as INITOSTY with the Save Style As command in 
the File Menu. This will be the default style setting for song one when you first 
load the program (see “Save Style As”, pages 55 - 56). 

INIT1.STY - Save a style file as INIT1.STY with the Save Style As command in 
the File Menu. This will be the default style setting for song two when you first 
load the program (see “Save Style As”, pages 55 - 56). 

Volume Changes 
Volume changes on an attached MIDI instrument will be active only if: 

the keyboard is velocity sensitive (volume-sensitive) and 
the specific preset (sound) is velocity sensitive. 

CORRECTIONS 
Volume (page 50) 
All sound options (internal, digitized, and MIDI sounds) respond to the volume slider 
setting and to inserted volume changes. 

(c) 1989 Activision P-198-09 
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An Introduction to The Music Studio 3.0 
Features of The Music Studio 3.0 

The Music Studio 3.0 is a fast, fun, creative way to compose, edit, orches- 
trate, record, and play music on your IBM IT or Tandy IO00 computer. 

Use its powerful tools to select instrumentation and place notes on the staff 
to compose a tune. You may change instruments, alter their sounds, speed 
up or slow down the tempo, change keys, and play back what you’ve 
written. Record your own performance on an attached MIDI instrument, 
and look at the score on the screen when you’re finished. If you have the 
Tandy sound feature in your computer, use a microphone to create your 
own sampled sound instruments to use in your songs. Save your work on a 
disk to retrieve at any time. 

The Music Studio 3.0 offers a number of special features for composing and 
playing back your musical compositions: 

standard musical notation including notes, rests, key and time 
signatures, accidentals, repeats, and more 

mouse or joystick operation, using intuitive “point and click 
tools for note entry 

powerful editing tools that move, repeat, or copy sections of a 
song and transpose passages up or down 

two different songs in memory at once for easy cutting and 
pasting between songs 

9 Up to 15 different instruments for orchestrating songs 

Real-time recording for recording music directly from a 
MIDI-equipped instrument 

MIDI compatibility to play back songs through MIDI- 
compatible instruments 

a full-featured waveform editor that edits and creates 
sampled sound instruments 
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How to Use This Guide 
This guide has three sections: 

“Setting Up The Music Studio 3.0,” which describes all the 
necessary hardware and software and shows you how to set up 
and run The Music Studio 3.0. 

“A Guided Tour of The Music Studio 3.0,” which takes you 
through all the basic features of The Music Studio 3.0. The tour 
makes stops along the way so you can experiment with the 
program and get a feel for how it works. 

The “Reference” section, which covers every aspect of The 
Music Studio 3.0, including those not covered in the guided tour. 
The “Reference” section is organized by the way things appear 
on the screen: the work area, controls, and menu commands are 
covered in turn. 

Important: Be sure to read through “Setting Up The Music Studio 3.0” to 
make sure everything is set up properly on your computer to run The Music 
Studio 3.0. You can then read through the guided tour at your leisure for an 
easy introduction to The Music Studio 3.0. When you have a general under- 
standing of how The Music Studio 3.0 works, take time to go through the 
“Reference” section to learn about the features not covered in the guided 
tour. 

If you’re adventuresome and prefer to explore The Music Studio 3.0 on your 
own instead of following the guided tour, go ahead! Just be sure to read the 
setup section fist. Once you’re set up, experiment The Music Studio 3.0 
is simple and straightforward and works the way you‘d expect it to. You 
can always turn to any part of the “Reference” section for details on a 
specific operation. (The “Reference” section table of contents is on page 
39.) You can also find specific information by using the index at the back 
of this guide. 

What You Need to Know Before Using This Manual 
Before you start using this manual, you should know the fundamentals of 
running your computer. Because The Music Studio 3.0 includes a run-time 
version of DeskMat@(an interface program used on the Tandy lo00 
computer that works also with IBM and IBM-compatible computers), you 
should know how to start your computer and how to run DeskMate using a 
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mouse or joystick. This manual teaches you enough about DeskMate to run 
The Music Studio 3.0; if you want to learn more, read the DeskMate manual 
that comes with the full version of DeskMate. Tandy lo00 owners receive 
DeskMate free with their computer; if you own an IBM or IBM-compatible 
computer, you can buy DeskMate at a nearby Radio Shack store; however, 
The Music Studio 3.0 includes a run-time version of DeskMate. 

If you can read music and understand the basics of MIDI (the Musical 
Instrument Digital Interface) and sampled sounds, you’ll find this knowl- 
edge useful as you use The Music Studio 3.0. If you don’t know anything 
about these topics, don’t wow! You can learn a lot just by taking the 
guided tour from start to finish, and you can still use The Music Studio 3.0 
to good effect. You’ll find short explanations of MIDI and sampled sounds 
in the “Reference” section. 

A Note on Instructions and Type Styles 
In this guide, boldface type shows words and messages that appear on the 
screen. Boldface also shows words for you to type or keys for you to press. 
For example, 

Press Esc 

means that you press the key that has the word Esc printed on it. The 
instruction “enter” asks you to type in the text that follows it and then press 
the Enter key to enter the text. For example, 

Enter cd mstudio 

means that you type the command cd mstudio and then press the Enter 
key. 

Keyboard accelerators are key combinations that perform a function. These 
combinations are shown with pluses between the key names. For example, 

Ctrl+P 

means that you press the Ctrl and P keys simultaneously. 

Mouse and joystick instructions often ask you to click the button. If you 
have a mouse or joystick with more than one button, click any button. If 
you’re using a joystick and the instructions ask you to move the mouse to 
the left or right, or drag it down, push or pull the joystick in the correspond- 
ing direction. 
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Now that you know how the manual works, read on to find out how The 
Music Studio 3.0 works. 
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Setting Up The Music Studio 3.0 
To run The Music Studio 3.0 you must first be sure that you have all the 
necessary equipment and disks. You should then copy your original The 
Music Studio 3.0 disks and set them aside for safekeeping. With copies in 
hand, you turn on your computer, run DeskMate, and then open The Music 
Studio 3.0. This section shows you how. 

Required Hardware 
To run The Music Studio 3.0 on your computer, you must have the follow- 
ing equipment: 

An IBM, IBM-compatible, or Tandy lo00 series computer with 
CGA, EGA, Hercules monochrome, or VGA graphics capabili- 
ties and a monitor capable of displaying those graphics. 

A mouse or joystick. 

Three blank 3 ln-inch floppy disks, double-sided and double- 
density, if your computer has a 3 Winch disk drive; OR four 
blank 5 1/4-inch floppy disks, double-sided and double-density 
if your computer has a 5 1/4-inch disk drive. Use these blank 
disks for storing songs and instruments and for making working 
copies of The Music Studio 3.0 disks. 

You may also want to use the following additional equipment to make your 
work easier and to improve the sound of your songs: 

An attached MIDI instrument (or several MIDI instruments) such 
as a keyboard synthesizer to play back songs and to play per- 
formances into The Music Studio 3.0 for recording. 

A MIDI adaptor card to connect external MIDI instruments. The 
Music Studio 3.0 works with the Rolandm MPU-401 MIDI card 
(or a compatible) or the MellotronTM MUART card. 

The Tandy sound feature in the lo00 SL and TL series Tandy 
computers. This capability adds a realistic sampled sound voice 
to the Tandy 1OOO. 
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A Tandy DMP 105,200,420 or 430 printer, an IBM-compatible 
graphics printer, or a Hewlett-Packard LaserJePor LaserJet- 
compatible printer. 

A hard disk drive to speed up saving and opening songs 
and instruments. 

Required Software 
To run The Music Studio 3.0, you need MS-DOS@3.2 or later, DeskMate, 
The Music Studio 3.0 program, and accompanying files. Most IBM or 
IBM-compatible computers should come with MS-DOS. DeskMate comes 
with the Tandy IO00 computer. If you don’t have DeskMate, The Music 
Studio 3.0 comes with a small run-time version of DeskMate. 

If you have a 5 1/4-inch disk drive, The Music Studio 3.0 supplies these 
disks: 

The Music Studio 3.0 Program disk 

The Music Studio 3.0 DeskMate Runtime disk 

The Music Studio 3.0 DeskMate Sounds and Songs disk 

If you have a 3 I@-inch disk drive, The Music Studio 3.0 supplies these 
disks: 

The Music Studio 3.0 Program and DeskMate Runtime 
disk 

The Music Studio 3.0 Sounds and Songs disk 

Copying Your Original Disks 
Before you do anything with The Music Studio 3.0 disks, take a few minutes 
to make copies of them to use as working disks and put the originals away 
for safekeeping. That way if anything happens to ruin your working disks, 
you can make another copy from the original. Remember that any copies 
you make are for your personal use only, and not for distribution to others. 
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Copying to Floppy Disks 
If you have a computer with a disk drive, follow these instructions to copy 
The Music Studio 3.0 disks. (If you have a hard disk drive, skip to the next 
section.) 

1. 

2. 

3. 

4. 

5. 

6. 

7. 

Look at the write-protect notch in the comer of each The Music Studio 
3.0 disk. For 3 1/2-inch disks, if the notch isn’t open, slide the black 
tab so you can see through the notch. For 5 1/4- inch disks, if the notch 
is open, put a piece of write-protect tape over the notch so you can’t see 
through the notch. This write-protects the original disks so you can’t 
accidentally erase them or write over them. 

Insert the MS-DOS disk in disk drive A and turn on the computer. 

When MS-DOS is loaded, the disk drive light goes out, and you see an 
A:> prompt on the screen. 

If you have a single disk drive, continue with these instructions 
to copy your disks. If you have two disk drives, move on to the 
alternate instructions that follow these. 

Enter diskcopy. MS-DOS gives you instructions for inserting disks; 
use The Music Studio 3.0 Program disk as the source disk and a 
formatted blank disk as the destination disk. 

Follow the MS-DOS disk-swapping instructions to make a copy. When 
MS-DOS asks if you want to make another copy, eject the disk that’s in 
the drive (be sure the drive light is out first) and label the copy disk as 
The Music Studio 3.0 Program disk. 

Enter Y to make another disk copy, and follow the same procedure to 
copy the other The Music Studio 3.0 disks. 

Enter N at the MS-DOS copy query when you’ve finished copying all 
the disks. The A:> prompt returns to the screen. 

If you have two disk drives, use these instructions to make disk copies: 

1. Follow steps 1 and 2 in the preceding instructions. 

2. Enter diskcopy a: b:. MS-DOS gives you instructions for inserting 
disks; use The Music Studio 3.0 Program disk as the source disk in 
drive A and a formatted blank disk as the destination disk in drive B. 
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3. Press Enter to start copying. When the copy is finished and MS-DOS 
asks if you want to make another copy, eject the disks in the drives (be 
sure the drive lights are out first) and label the copy disk as The Music 
Studio 3.0 Program disk. 

4. Enter Y to make another disk copy, and follow the same procedure to 
copy the other The Music Studio 3.0 disks. 

5. Enter N at the MS-DOS copy query when you’ve finished copying all 
the disks. The A:> prompt returns to the screen. 

Copying to a Hard Disk without DeskMate 
If you have a hard disk installed in your computer and don’t have DeskMate 
already installed, follow these instructions to copy the contents of The 
Music Studio 3.0 disks onto your hard disk. 

Note: It is a good idea to make backup floppy disks as described in the 
previous section even though you have a hard disk. 

1. Look at the write-protect notch in the comer of each The Music Studio 
3.0 disk. For 3 1/2-inch disks, if the notch isn’t open, slide the black 
tab down so you can see through the notch. For 5 1/4-inch disks, if the 
notch is open, put a piece of write-protect tape over the notch so you 
can’t see through the notch. This write-protects the original disks so 
you can’t accidentally erase them or write over them. 

2. Turn on your computer. A C: prompt appears on the screen. 

3. Enter md mstudio to create a new directory named MSTUDIO on the 
hard disk. 

4. Enter cd mstudio to change to the MSTUDIO directory. 

5. Insert The Music Studio 3.0 Program disk in drive A. 

6. Enter copy a:*.* c: to start copying. MS-DOS copies all the files from 
The Music Studio 3.0 Program disk to the MSTUDIO directory on the 
hard disk drive. 

7. When the disk file copy is finished and the floppy disk drive light is 
out, eject The Music Studio 3.0 Program disk and repeat steps 5 and 6 
to copy the contents of the other The Music Studio 3.0 disks onto the 
hard disk drive. 
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8. When you’ve finished copying the contents of all the disks, enter c: \ to 
return to the hard disk drive root directory, then eject any remaining 
The Music Studio 3.0 disks. 

You have just copied The Music Studio 3.0 program and its associated files 
into its own directory. Any time you run The Music Studio 3.0 from the 
hard disk, you must enter the MSTUDIO directory first. 

Copying to a Hard Disk with DeskMate 
If you have a hard disk installed in your computer and have DeskMate 
already installed, follow these instructions to copy the contents of The 
Music Studio 3.0 disks onto your hard disk. 

1. Follow steps 1 through 5 in “Copying to a Hard Disk without 
DeskMate.” 

2. From the Program and Sound and Song disks, copy only the Program 
file (MSTUDIO. PDM), Configuration file (*.CFG), Sound file 
(*.SND), and Song file (*. MSS). 

Creating a Blank Disk for  Song Storage 
If you don’t have a hard disk drive, format a blank disk that you can use 
later to save songs and instruments you create in The Music Studio 3.0. 

1. Place a blank disk in drive A. 

2. Enter format a:. MS-DOS asks you to insert the disk you want 
formatted in drive A. 

3. Insert the blank disk in drive A and press Enter to start formatting. 
MS-DOS tells you its progress as it formats the disk, and when 
finished asks if you want to format another disk. 

4. Enter n to stop the formatting process. 

5. Eject your newly formatted disk (be sure the drive light is out first) and 
label it as a Song and Instrument Storage disk. 

Once you’ve copied The Music Studio 3.0 disks, you can run DeskMate and 
The Music Studio 3.0 from your copies and put away the original disks for 
safekeeping. 
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Running The Music Studio 3.0 
The instructions that follow are for four different situations: 

9 Working from 3 1/2-inch floppy disks or 5 1/4-inch floppy disks 
if you don’t have DeskMate 

Working from 3 1/2-inch floppy disks or 5 1/4-inch floppy disks 
if you do have DeskMate 

Working from a hard disk drive if you don’t have DeskMate 

Working from a hard disk drive if you do have DeskMate 

Follow the set of instructions appropriate to your situation. 

Working from Floppy Disks without DeskMate 

1. Insert the DeskMate Runtime Software disk in drive A. 

2. Enter Music to start DeskMate. 

3. You’ll be asked to insert a disk containing MSTUDIO.PDM. Insert the 
Program disk in any drive (if you have 3 1/2-inch disks, keep 
in the same disk.) 

Working from Floppy Disks with DeskMate 

1. Bring up DeskMate by typing desk or booting DeskMate from ROM. 

2. Pull down the Desktop menu and select Install. 

DeskMate will create a window called MUS STUDIO on the Desktop 
screen. 

3. Select Music Studio from the MUS STUDIO window by pointing to it 
with the cursor and clicking the mouse or joystick button. 

Working from a Hard Disk Drive without DeskMate 

1. If you haven’t already done so, copy your disks and create a Music 
Studio directory as described in the “Copying to a Hard Disk without 
DeskMate” section earlier in this manual. 
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2. Change to the MSTUDIO directory if you’re not already in 
that directory. (Use the command cd mstudio if you just turned 
on your computer.) 

3. Enter Music to start the run-time version of DeskMate. The Music 
Studio 3.0 opens on the screen. 

Working from a Hard Disk Drive with DeskMate 
1. If you haven’t already done so, copy your disks and create a Music 

Studio directory as described in the “Copying to a Hard Disk with 
DeskMate” section earlier in this manual. 

2. Bring up DeskMate by typing desk or booting DeskMate from ROM. 

3. Pull down the Desktop menu and select Install. 

DeskMate will create a window called MUS STUDIO on the Desktop 
screen. 

4. Select Music Studio from the MUS STUDIO window by pointing to it 
with the cursor and clicking the mouse or joystick button. 

Quitting The Music Studio 3.0 
To quit The Music Studio 3.0 and return to the Desktop, press Esc or choose 
Exit from the File menu. 

Note that if you did any work in The Music Studio 3.0, it asks you if you 
want to save your work before you return to the Desktop. Answer No to 
quit the program without saving anything you entered. (If you’ve created 
something you really want to save, answer Yes. You can find directions in 
the “Reference” section of this manual for using the Save File dialog box 
that appears.) 
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A Guided Tour of The Music Studio 3.0 
Chapter 1- 
A Look Around The Music Studio 3.0 
Now that you have everything set up, open The Music Studio 3.0 to take a 
look around. 

The Music Studio 3.0 Screen 

- Menu Bar 
7 Bar 

-Controls 

The Music Studio 3.0 screen has four main sections: 

the work area where you create songs by entering notes on 
musical staves 

the controls that you use to control song playback 

the menu bar that contains menu commands you use to 
compose, record, edit, play, and save songs 

the title bar that tells you the name of the song or file you’re 
working on 
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The WorkArea 

Staff Scroll Bar - 

SonaNumber h 

I FName 

Song Scroll Bar Time Signature I / 

\ /  I I 
Play I Message I 

Key 
Signature 

I 
Volume Tempo 

Button Area 
Note 
Value 

The grand staff, made of the upper staff (in treble clef) and the lower staff 
(in bass clef), is in the middle of the work area. Although you see only the 
grand staff when you first open The Music Studio 3.0, you can add as many 
as seven more staves. As you move the pointer over the staves, it turns into 
a note shape called the note pointer. You place notes in a song by position- 
ing the note pointer on a staff and clicking the mouse or joystick button. 

Note: The instructions in the rest of this manual refer only to the mouse. If 
you’re using a joystick and the instructions ask you to move the mouse to 
the left or right, or drag it down, push or pull the joystick in the correspond- 
ing direction. 

Two scroll bars control the view in the work area: the song scroll bur along 
the bottom of the work area and the stufscroll bar along the right side of 
the work area. The song scroll bar scrolls horizontally through music on the 
staves; the staff scroll bar scrolls vertically through staves in the work area. 

The message area in the bottom righthand side of the work area shows the 
current instrument name and the pitch at the current location of the note 
pointer. 
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The Controls 
The controls below the work area control song playback. They are: 

Play Button - starts song playback 

Key Signature - sets the key for your songs 

Time Signature - sets the time signature for your songs 

Tempo - sets playback tempo from slow (56 beats per minute) to fast (220 
beats per minute) 

Volume - sets playback volume of newly entered notes from soft (pp) to 
loud (ff) 

Note Value - sets the duration value of the new notes or rests you insert in a 
staff 

The Menus 
The menus in the menu bar contain commands that work on your songs: 

The File menu commands save and open songs and The Music Studio 3.0 
settings from disk. They also print out a song on an attached printer and 
quit The Music Studio 3.0 when you're finished working. 

The Edit menu commands cut, copy, and paste music within a song and/or 
between songs. They also switch between two songs and perform sophisti- 
cated filter editing. 

The Options menu commands contain some of The Music Studio 3.0's 
most powerful tools. They add new staves, create, alter, and set instru- 
ments, record performances from attached MIDI instruments, and set MIDI 
parameters for playback on MIDI instruments. They also set the voices that 
play songs and perform other important functions. 

The Notation menu commands add important musical notation such as 
crescendi, diminuendi, repeats, measure bars, beams, ties, and slurs to a 
song. 
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The Notes & Rests menu commands change the type of notes and rests 
you add to a song by adding dots, accents, staccato marks, accidentals, and 
triplet-markings. One command changes the note pointer to a rest pointer 
for inserting rests in a song. 

The Goodies menu commands perform most of the operations of the 
controls below the work area-changing tempo, volume, time signature, 
key signature, and performing other operations. 
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Chapter 2-Playing a Song 
Playing a song in The Music Studio 3.0 is a simple matter of opening a song 
from disk and clicking the Play button. Voila! Music plays .... To make 
playback even more entertaining, you can set the controls below the work 
area to change playback tempo or volume. 

Opening a Song 
The Music Studio 3.0 Sounds and Songs disk includes several sample songs 
you can open and play to hear what The Music Studio 3.0 can do. First 
make sure The Music Studio 3.0 is open (open it again if you quit it previ- 
ously). Then: 

1. Insert the Sounds and Songs disk in drive A (this isn’t necessary if you 
copied the Sounds and Songs disk onto your hard disk). 

Choose Open from the File menu. (To choose a command from a 
menu, move the pointer to the menu name you want on the menu bar. 
Once there, hold down the mouse button to open the menu, then drag 
the pointer down the list of commands in the menu until you point to 
the one you want. Release the button to choose the command under the 
pointer. The menu closes and The Music Studio 3.0 executes your 
command.) When you choose Open from the File menu, the Open 
File dialog box appears. 

2. 

BOOGIE. HSS 
BOSSA. HSS 

3. Click the Open File: box, then type A: in the box and press Enter. The 
Files list box shows all the songs available on the Sounds and Songs 
disk. (The Music Studio 3.0 song filenames all end in .MSS.) 
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Note: If you have a hard disk drive, you don’t need to enter A: to change 
drives. You copied all the songs to the hard disk in the last section; they 
should already appear in the Files list box. 

4. Point to the song BLUES.MSS and double-click the mouse button. 
(Doubleclick means to move the pointer over the song name to 
highlight it, and then click the mouse button twice in rapid suc- 
cession.) The dialog box closes and the song BLUES appears in 
the work area. 

Playing a Song 
You can play the song by clicking the Play button; the song plays through 
to the end unless you press a keyboard key to stop it. 

1. Click the Play button. BLUES starts to play, and a message on the 
screen tells you to press the space bar to stop playback. 

2. Press the space bar to stop playback. The sound stops. 

3. Click the Play button once again, and listen to the entire song. 
Playback stops at the end of the song. 

Note that the Tandy lo00 L series of computers has different playback 
voices you can use to play back songs. The “Reference” section of this 
manual tells you how to turn on these voices. 

Changing Tempo 
Changing the playback tempo (the speed of playback) is a fun way to 
change the way the song plays back. Use the tempo control: 

1. Move the pointer to the block in the center of the tempo control’s 
slider. Hold down the button and drag the slider to the right. As you 
do so, the tempo value below the slider increases. Release the button 
when the value reads 200 (or close to it). 

2. Click the Play button. The song plays back at a much faster tempo. 

3. Listen to the whole song, or press the space bar to stop playback. 
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Chapter Scornposing a Song 
Composing music from scratch is easy with The Music Studio 3.0. You 
enter the notes and rests of your song on the staves in the work area and 
then listen to the song immediately by clicking the Play button. If you want 
to add more music, delete some notes, or rework your entire song, you can 
use the commands on the Edit menu and the note pointer to change what 
you wrote, and then play it back to see if you like your changes. 

This chapter shows you how to write a song from scratch. You won’t 
actually compose your own song this time; instead you recreate an old 
standby-“Frere Jacques.” 

If you quit The Music Studio 3.0 after the last chapter, open it now and find 
the blank, formatted disk you created earlier; you need it to save the song 
you create. 

Placing Notes on the Staff 
To create music in the work area, you place notes on the staff. If there are 
already notes in the work area, clear them, and then enter the first notes of 
“Frere Jacques”: 

1. Choose New from the File menu to clear the work area. A dialog box 
asks if you want to save any changes in the song. Click the NO button 
to close the dialog box without saving any changes. 

2. Pull down the Options menu and look at the Note Sound Off option. 
If there is a check before it (which means the note sound is off), choose 
Note Sound Off to remove the check and turn the note sound on. 
(Note Sound On asks The Music Studio 3.0 to sound pitches as you 
move the note pointer up and down on the staff.) 

3. Point to the grand staff-the pointer changes to the note pointer. 
Pitches sound as you move up and down the grand staff; each line and 
space in the staff has its own pitch. As you move left and right on the 
staff, the note pointer jumps from space to space. Each horizontal 
position it holds on the staff is called a column. 



24 A Guided Tour of The Music Studio 3.0 

4. 

5. 

6. 

7. 

8. 

9. 

Note Pointer 

Move the head of the note pointer (the circular part of the note) 
exactly between the two staves in the fist column (the left side of the 
work area). This pitch position is middle C. (Read the pitch name to 
the right of the key control to make sure you are at the right pitch.) 

Click the mouse button to place a quarter note at middle C in the 
first column. 

Move the note pointer to the next column to the right and then up a 
step to the pitch just below the bottom line of the upper staff (a D 
pitch). Click the mouse button to place a quarter note here. 

Move the note pointer again one column to the right and one 
pitch up to the bottom line of the upper staff. Click again. An E 
quarter note appears. 

Move the note pointer to the right of the E and down two steps 
to middle C again. Click to place the note. The four notes (C, D, E, 
C) you’ve entered are the first four-beat measure of “Frere Jacques.” 

Click the Play button to play the notes. 

Deleting and Changing Notes 
If you accidentally place a wrong note on the staff, move the head of the 
nok pointer over the head of h e  note and click the mouse button: the wrong 
note disappears from the staff. You can now enter the correct note. 
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Selecting a Music Block 
“Frere Jacques” has four repeating measures of music-each measure plays 
twice. If you enter a measure and then copy it to produce a second identical 
measure, you save a lot of work in note entry. To do so, you must first 
select a section of music in the work area called a music block. Once you 
select a music block, the editing commands you choose from the Edit menu 
work on just that music block. 

To select a music block, you move the pointer to the upper or lower edge of 
the work area; a vertical line called a block selector appears on the staff. As 
you move the pointer left and right along the edge of the work area, the 
block selector moves left and right. You click the mouse button to place the 
block selector at the location you want, and then repeat the procedure to put 
a second block selector in the song. The two selectors define a music block. 
Try it on the four-note measure you just entered: 

1. 

2. 

3. 

4. 

Point to the bottom of the work area just above the scroll bar and 
below the first note in your song. A block selector appears. Move it 
just to the left of the first note. 

Click the mouse button. The block selector is set before the first note. 

Point to the bottom of the work area below the last note in the four-note 
measure. A second block selector appears. Move it just to the right of 
the last note. 

Click the mouse button. The music between the two block selectors 
appears highlighted these four notes are now selected as a music block. 

If you didn’t set the music block properly, remove it by moving the pointer 
to the top or bottom edge of the work area and clicking to set a new block 
selector. The music block disappears. Set a second block selector to define 
a new music block. 
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Copying a Music Block 
Once y ~ u  select a music block, you can use the commands on the Edit 
menu to perform an editing action on the block. The Copy command 
copies the contents of the music block into a section of memory called the 
clipboard without disturbing the music in the song. The Paste command 
inserts whatever music is stored in the clipboard into the song. Use both of 
these commands to copy the four-beat measure you just selected as a music 
block 

1. 

2. 

3. 

4. 

5. 

Choose Copy from the Edit menu to copy the measure to the 
clipboard. A C appears to the right of the song scroll bar, indicating 
there’s something in the clipboard. 

Set a new block selector at the end of the measure by moving the 
pointer to the location along the top edge of the work area and then 
clicking the mouse button. The music block disappears and a single 
block selector appears on the staff. 

Choose the Paste command from the Edit menu to copy the contents of 
the clipboard to the song at the location of the block selector. A copy 
of the measure appears next to the original measure. 

Select Auto-Insert Measures from the Notation menu. Measure bars 
are automatically inserted in the proper places. 

Click the Play button to hear both measures play. 

Changing Note Values 
The third measure of “Frere Jacques” has three notes: two quarter notes 
followed by a half note. (A half note plays twice as long as a quarter note 
and looks like a quarter note with a hollow note head.) Enter the two 
quarter notes on the staff, then change the note value to a half note and enter 
a half note: 

Quarter Note 

I Half Note 
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1. 

2. 

3. 

4. 

5. 

6. 

7. 

Enter a quarter note E (on the bottom line of the top staff) 
immediately following the last note of the staff. 

Enter a quarter note F (on the space above the E) in the column 
following the E. 

Move the pointer to the staff to enter a G note (on the second line 
from the bottom of the top staff) immediately after the F note. Hold 
down the mouse button while rolling the mouse up or down to change 
the note value. The value is shown in the note value control box in the 
lower right comer of the screen. When the note value control box 
shows a half note, release the mouse button. 

To create the fourth measure, copy the three notes you’ve just entered 
by selecting them as a music block and then choosing Copy from the 
Edit menu. 

Paste the copied notes back in the song by setting a single block 
selector at the end of the song and choosing Paste from the Edit menu. 

Select Auto-Insert Measures to organize the newly entered notes 
into two measures. The fourth measure, the copy of the notes in the 
third measure, appears. 

Click the Play button to play the song. You can hear the first four 
measures - half of the song! 

Scrolling through a Song 
The first four measures of “Frere Jacques” fill up the work area with notes 
and leave little room to add new notes at the end of the song. The left and 
right edges of the work area (just inside the staff scroll bar) are scroll zones. 
When you place the pointer in a scroll zone, small arrows appear in the 
corners of the work area to show you which direction you will scroll. You 
then click the mouse button and the song scrolls one column in that direc- 
tion. Hold the mouse button down to continually scroll in that direction. 

Try scrolling right to open up more space to the right of the notes you just 
entered: 

1. Move the pointer to the right end of the staff. Small right arrows 
appear at the upper and lower right comers of the work area. 
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2. Hold down the mouse button to scroll to the right until only the last 
note shows on the left of the staff. 

3. Release the mouse button to stop scrolling. 

If you scroll too far, move the pointer to the left end of the staff and scroll 
left until the last note shows on the staff. 

Adding Dotted Notes 
The next measure begins with a dotted eighth note. (An eighth note is half 
the length of a quarter note. A dot added to a note means the note plays half 
again as long as it usually does, so a dotted eighth note plays one and a half 
times as long as a regular eighth note.) The notes that follow are a sixteenth 
note, another dotted eighth note, another sixteenth note, and two quarter 
notes. Enter them at the end of the last measure in the song: 

Dotted Eighth Note 

Sixteenth Note 

1. 

2. 

3. 

4. 

5. 

Use the note value control box to choose an eighth note (which looks 
like a quarter note with a single flag on its stem): Move the pointer to 
the note value control box, press the mouse button, drag the mouse up 
or down until the eighth note appears, then release the mouse button. 

Choose Dotted from the Notes & Rests menu. A dot appears after the 
note in the note value control box. 

Move the pointer to the staff and place a G note following the end of 
the fourth measure. (G is the second line from the bottom of the 
top staff.) 

Move the pointer over two columns to the right and place another 
dotted G note. 

Choose Dotted once more from the Notes & Rests menu. The dot 
disappears from the note value control box. 
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6. Use the note value control box to choose a sixteenth note (a note with 
two flags on its stem). 

7. Move the pointer to the empty column between the two dotted G notes 
you just placed and place an A sixteenth note. (Use the second space 
from the bottom of the top staff). 

8. Point past the second dotted G note and place an F. (Use the first space 
from the bottom of the top staff). 

9. Select a quarter note in the note value control box. 

10. Enter a quarter note E followed by a quarter note C to finish the 
measure. 

11.’ Copy the six-note measure using the Copy command, then paste it at 
the end of the song using the Paste command. 

12. Select Auto-Insert Measures to organize the newly entered notes into 
the fifth and sixth measures. 

13. Now, on your own, add these last two measures to the song: 
I 

14. Click the Play button to play the entire song. 

Saving Your Work 
After you create a song, you’ll want to save it to disk so you can open it and 
play it later. If you don’t have a hard disk drive, save the song to the blank 
disk you created earlier: 

1. Insert the blank disk in drive A. (Eject the disk there, if necessary.) 

2. Choose Save Song as from the File menu. A Save File dialog box 
appears. 

3. Type the name A:FRERES in the Save Song as box to name the song 
FRERES and save it on drive A. 
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4. Press Enter to save the song to disk. The Save command automati- 
cally adds the file extension .MSS to the name and saves the song. 

If you have a hard disk drive, save the song to the hard disk: 

1. Choose Save Song as from the File menu. A Save File dialog box 
appears. 

2. Type the name FRERES in the Save Song as box to name the song 
FRERES and save it on the currently selected drive-the hard 
disk drive. 

3. Press Enter to save the song to disk. The Save command automati- 
cally adds the file extension .MSS to the name and saves the song. 

Once you save a song with the Save command, the file name you enter 
appears in the title bar. If you choose the Save command instead of Save 
Song as, The Music Studio 3.0 replaces the old (last saved) version of your 
song with the current version that’s on the screen. To save a previously 
saved song as a new file with a new name, or to save different versions of 
the same song, choose Save Song as from the File menu. The Save File 
dialog box appears, and you can enter a new name and specify a new disk 
drive if you want. 

It’s a good idea to save your song frequently while you work on it. Then if 
the power goes out or some other mishap occurs, you always have some of 
your work saved on disk. If you save every 15 minutes, then you can’t lose 
more than 15 minutes of work. 
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Chapter 4-Using MIDI 
If you have a MIDI instrument such as a synthesizer or a drum machine, 
you can use The Music Studio 3.0 to play songs on the instrument, or you 
can record your performances on the instrument as a song in The Music 
Studio 3.0. First you must connect the instrument to your computer with 
MIDI cables and a MIDI interface card. The beginning of this manual lists 
the interface cards that work with The Music Studio 3.0; once you have the 
card, you must install it in the computer following the instructions that 
come with the card. Using MIDI cables, plug your MIDI instrument into 
the card. 

Once your MIDI instrument is connected, you can specify instrument 
changes within a song to play back the song over the MIDI instrument using 
the instrument’s different sounds (usually called patches). You then set The 
Music Studio 3.0 to communicate with your MIDI instrument over the 
proper MIDI channels using the preset numbers you want. 

Note: If some of the MIDI terms are confusing U, you, see the brief MIDI 
tutorial in the “Reference” section that introduces you to some of MIDI’S 
fundamental concepts. 

Making MIDI Connections 
Although different MIDI instruments have different MIDI ports on them, 
most have a MIDI In port and a MIDI Out port. To make connections with 
the MIDI interface card, you use one MIDI cable to connect the MIDI In 
port of the instrument to the MIDI Out port of the interface card. You use a 
second MIDI cable to connect the MIDI Out port of the instrument to the 
MIDI In port of the interface card. Connecting the instrument MIDI Out to 
the interface card MIDI In is necessary if you want to record your perform- 
ances as a song. Connecting the interface card MIDI Out to the instrument 
MIDI In is necessary to play back your songs on the MIDI instrument. For 
more information on connections, read the manuals that came with your 
interface card and your MIDI instrument. 

Using Different Instruments During Note Entry 
When you enter notes on a staff in the work area, the message area to the 
right of the Key button lists an instrument name. All notes you enter play 
back using that instrument. The Music Studio 3.0 has 14 other instruments 
you can use to enter notes. When you choose a new instrument, the 
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instrument’s name appears in the message area, and all notes you enter play 
back using the new instrument. To help you see where different instru- 
ments are used for note entry, each instrument has its own texture (or color, 
if you’re using a color system). Notes entered with one instrument have a 
note head made of a different texture (or color) than notes entered with a 
different instrument. 

Try using four different instruments as you re-enter “Frere Jacques”: 

1. If you have music in the work area, choose New from the File menu to 
clear the work area. 

2. Enter the first two measures of “Frere Jacques” (shown below). The 
instrument you’re using to enter notes is Guitar, the instrument listed 
in the message area. The notes representing the Guitar appear in solid 
black. 

I 

3. Choose Select Instrument from the Options menu. The Select 
Instrument Dialog box opens. The instrument list on the lcft of the box 
shows the name of each instrument available beside the texture or color 
of the instrument. 

0 
m 
0 
0 
0 
0 
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0 
0 
0 
0 
0 
0 
0 

a 

_I 

Display 

IXI 

IXI 
Change Name 
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Using MIDI 33 

4. Click the name Clarinet, then click OK to close the dialog box. 
The dialog box closes and the note in the note value control box, 
which now represents the Clarinet, turns an evenly textured gray 
or blue. 

Note: The specific colors indicated in this manual are what are seen in 
EGA color or Tandy 16 color modes only. The colors on a VGA or CGA 
monitor may differ. 

5. Enter the next two measures of “Frere Jacques” (shown below). The 
notes you enter on the staff are an evenly textured gray or blue, indicat- 
ing that you’ve selected the Clarinet. 

6. Choose Select Instrument from the Options menu and select 
Violin as a new instrument. 

7. Enter the next two measures of “Frere Jacques” (shown below). The 
notes you enter for the Violin appear as vertical bars or are red in color. 

I 
8. Select Piano as a new instrument and enter the last two measures of 

“Frere Jacques” (shown below). The notes representing the Piano are 
a lightly textured gray or pink in color. 
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9. Use the Save Song as command to save the song to disk and 
name it FRERE2 so you can keep it safe for playback over your 
MIDI instrument. 

Note that you can change instruments as you enter notes without using the 
Select Instrument dialog box: Press any of these keys: 1,2,3,4,5,6,7,8,  
9, A, B, C, D, E, or F. These 15 speed keys correspond to the 15 instru- 
ments in the Select Instrument dialog box. For example, if you press 2, the 
instrument changes to Clarinet (the second instrument on the list); if you 
press F, you get Voice (the fifteenth instrument on the list). 

Choosing MIDI Settings 
To play back your composition using the different patches on your MIDI 
instrument, you must set the way The Music Studio 3.0 communicates with 
your instrument. For this example, leave the MIDI channel set to 1 (almost 
all MIDI instruments receive on channel 1 without any special settings), and 
use preset numbers 1,2,3, and 4 to choose presets on your instrument. 
These numbers choose the first four presets of your instrument, which could 
be anything from Fuzz Marimba to Bass Nose Flute. The actual presets 
don’t matter; only the fact that you’re using different presets matters. 

Set new MIDI settings following these instructions: 

1. 

2. 

Open the song FRERE2 in the work area if it isn’t there already. 

Choose MIDI Settings from the Options menu. The MIDI Settings 
dialog box appears. 

lcui tar  

Ix1 

Block Staff 
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3. 

4. 

5. 

6. 

7. 

8. 

9. 

Select Guitar from the instrument list. (This is the fist of the four 
instruments you used in “Frere Jacques.”) The three boxes at the top of 
the dialog box list the Guitar’s channel as 1, with its preset as 1, and its 
volume as V. These settings are what you want, so leave them as they 
are. 

Select Clarinet from the instrument list. (This is the second of the four 
instruments.) 

Select the Preset box at the top of the dialog box by pointing to it and 
clicking the mouse button, then use the keyboard to erase the current 
value and enter 2. This means that the Clarinet voice plays using 
preset 2. 

Select Violin (the third instrument) from the instrument list. The 
’Channel, Preset, and Volume boxes change to show the Violin settings. 
The values to the right of the Clarinet name change to show the 
Violin’s new settings. 

Select the Preset box and enter 3 to choose preset number 3 for the 
Violin voice. 

Select Piano (the fifth instrument) from the instrument list. 

Enter the value 4 in the Preset box to choose preset number 4 for 
the Piano voice. 

10. Click OK to close the dialog box and accept your settings. 

Playing Back a Song via MIDI 
Once you have the MIDI settings you want, MIDI playback is simple: 

1. 

2. 

3. 

Turn on your MIDI instrument and make sure it’s set to receive MIDI 
messages on the channels you’re using to transmit. (Most instruments 
should receive messages on all channels, so you won’t have to set 
anything new. Check your instrument’s manual if you’re not sure.) 

Check the Options menu to make sure that MIDI is turned on and all 
the computer’s internal voices are turned off. 

Click the Play button. You hear “Frere Jacques” play. The Guitar 
notes now play using preset 1 on your synthesizer, the Clarinet part 
uses preset 2, the Violin part uses preset 3, and the Piano part uses 
preset 4. 
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Saving MIDI Settings 
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Once you’ve chosen the MIDI settings and playback options that you like, 
you can save them to disk by choosing Save Config from the File menu. 
Save Config saves the current MIDI settings, instrument settings, playback 
options, and other settings to disk so that the next time you open The Music 
Studio 3.0 the settings are still in effect. 

Recording a MIDI Performance 
To record a MIDI performance as a song, you first decide on a tempo and 
then use the MIDI Record command: 

1. Choose New from the File menu to clear the work area if there’s 
music already there. 

Set the tempo slider to the tempo you want to use for the beat in 
your performance. 

3. Choose MIDI Record from the Options menu to open the MIDI 
Record dialog box. 

2. 

Hetronome 

Quantize e 
co lumns  r e c o r d e d  

-mm= !mi== 
4. Point to the box to the right of Metronome and click the mouse button, 

then select Start Record. You’ll hear clicks from the computer’s 
speaker at the tempo you set with the tempo control. 

5. To start recording, play the music you want, following the beat 
of the metronome. 

6. Press the space bar to end recording. 
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7. Choose OK to close the dialog box and look at the song you just 
recorded. (The Cancel button closes the dialog box and forgets 
the performance you recorded.) 

8. Click the Play button to hear your performance replayed. 

You’ll probably find a lot of sixteenth notes and other small note values in 
the song you just recorded. That’s because human performances rarely, if 
ever, fall directly on the metronome beat, and a direct transcription of the 
performance yields small note values instead of easily readable longer notes 
that fall directly on the beat. Select the Quantize feature in the MIDI 
Record Dialog box before you begin to record, or use the Set Edit Filters 
and Filter commands to clean up some of these small notes and uneven 
beats. These options are more thoroughly explained in the “MIDI Rec- 
ord,” “Set Edit Filters” and“Fi1ter”entries in the “Reference” section of 
this manual. 

Note that whenever you record a MIDI performance, the MIDI Record 
command appends your new notes to the end of any music already in the 
work area. Each time you record, you add a new section to the music. If 
you record something you don’t lke, use the Erase button in the MIDI 
Record dialog box to erase the section you just recorded. 
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Reference Contents 
This “Reference” section is organized by the way things appear on the 
screen: It illustrates and explains the work area and the playback tools that 
appear below the work m a .  It then goes on to list commands in the menus 
in the order in which they appear. 

The Music Studio 3.0 Screen 
Work Area 

Grand Staff 
Scroll Handles 
Song Scroll Bar 
Song Slider 

Current Column/Measure Number 
Last Colurnfleasure Number 

Staff Scroll Bar 
Staff Slider 
Current Staff Number 
Last Staff Number 

Block Selectors and Music Blocks 

Play Button 
Message Area 
Key Signature 
Time Signature 
Tempo 
Volume 
Pitch Name 
Note Value 

Controls 
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Reference Contents continued 

Menus 
File Menu 

New 
Open Song 
Save Song 
Save Song as 
Open Style 
Save Style as 
Save Config 
Print 
Exit 
Run 

Edit Menu 
cut  

COPY 
Paste 
Clear 
Add Column 
Filter 
Merge 
Home Song 
Switch Song 

Song Setup 
Select Instrument 
Set Note Style 
Set Edit Filters 
Notes Filter 

Options Menu 

Note Stems Filter 
Volume Filter 
Duration Filter 
Instrument Filter 
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Reference Con tents continued 
Design Sound 

Sampled Instrument Fundementals 

MIDI Fundamentals 

MIDI Recording Fundamentals 

Number Measures 
Note Sound Off 
Internal Sound Off 
Digitized Sound Off 
MIDI Off 

MIDI Settings 

MIDI Record 

Toggle Options 

Notation Menu 
CrescendoDiminuendo 
Add Repeat 
Auto-Insert Measures 
Insert Measure Bar 
Beam 
Tie 
Slur 

Notes -& Rests Menu 
NOTE -> Rest (Note <- RESV 
Flip Note 
Triplet 
Dotted 
Accent 
Staccato 
Use Key 
Natural 

Sharp 
Flat 

70 
71 
75 
76 
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Reference Contents continued 

Goodies Menu 
Play Entire Song 
Play Current Staff 
Play Marked Block 
Play Clipboard 
Key Signature 
Time Signature 
Insert Tempo 
Insert Volume 
Available Memory 
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The Music Studio 3.0 Screen 

-Menu Bar 

7'" Bar 

The Music Studio 3.0 screen has four main parts: 

The title bar lists the date and time, the fiie name of the program 
(The Music Studio 3.0), and the file name of the current song. 

The menu bar contains menus with commands that load, 
save, edit, and perform other useful functions on the song in 
the work area. 

The work area displays the contents of a song, and is the place 
where you enter, delete, and manipulate notes and rests. 

The controls start song playback, and control the tempo and 
volume of playback (among other things). 
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The Work Area 
Current Staff 

Block Selector Uppe,r Staff Scroll Handles Number 

Scroll H 1 
Song Scroll Bar 
\ 

Current Column/ Lower Staff Last Column/ Last Staff 
Measure Number Measure Number Number 

Grand Staff 
The grand staff is in the middle of the work area, and is made of the upper 
staff and the lower staff. 

To place notes on the grand staff: 

Move the note pointer to the location you want and click the 
mouse button. 

You can place up to 15 notes in a single column. A horizontal line below 
the grand staff shows the lower limit where you can enter notes. (For more 
information on adding notes and rests and setting their values, see the 
“Notes & Rests Menu” entry later in this “Reference” section. ) 

Note: The screen is limited in the number of notes it will display at one 
time. If you exceed this number, a dialog box appears saying the display is 
too complex to fit the screen, and the last few notes you entered won’t 
appear on the screen. These notes aren’t deleted; they just aren’t displayed 
on the screen at this time. If you want to see these notes, scroll the screen 
forward until you see the last few columns of notes you entered. 
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Scroll Handles 
To move back and forth through a song: 

Point to the left end of the staff to move toward the beginning of 
a song. 

Point to the right end of the staff to move toward the end of a 
song. 

Small arrows appear above and below the staff. 

Press the mouse button to begin scrolling. 

Release the mouse button to stop scrolling. 

Song Scroll Bar 
Use the song scroll bar at the bottom of the work area to quickly move back 
and forth through the song. The length of the song scroll bar from left to 
right represents the length of the song visible on the screen: Point to the 
position you want on the scroll bar and click the mouse button to quickly 
move to the song location you want. 

You can also scroll through a song 16 columns (one screen) at a time by 
pressing the left and right arrow keys on the keyboard. 

Song Slider 
The song slider shows your current location in a song. Point to the left edge 
of the song slider, hold down the mouse button and drag the slider to a new 
location; the current column/measure number at the left end of the song 
scroll bar changes as you drag the slider to show you the column or measure 
number of the slider location. 

Current ColumnlMeasure Number 
The current column/measure number shows the location of the note pointer 
as you move the pointer along the staff and the song slider location as you 
drag the slider. The current column/measure number usually shows 
location by column, but if you add measure bars to a song and turn on the 
Number Measures option in the Options menu, the number shows 
locations by measure. If there are no measures marked in your song, the 
current measure number will always be 1. 
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To jump to the beginning of a song, point to the current column/measure 
number and click the mouse button. 

While you’re playing back a song, the notes on the screen don’t change to 
show the song as it’s being played; you can tell your position in the song by 
looking at the current column/measure number. The current column/ 
measure number changes to show the number of each column as it’s played. 
If you press the space bar to stop playback, the current column/measure 
number changes to show the number of the far left column of notes dis- 
played on the screen. Note that the current column/measure number only 
applies to the top staff displayed on the screen. 

If you press the ESC key to stop playback, the notes on the screen do 
change to display the position of the song where you stopped it. The 
current column/measure number shows the column in the song where you 
stopped playback, which is now the first column on the far left of the 
screen. 

Lust ColumnlMeasure Number 
The last column number shows the number of the last column (or measure if 
the Number Measure option is turned on) in the song. Use it to see how 
long the song is. Use it also to jump to the end of the song: Point to the 
number and click the mouse button. 

Staff Scroll Bar 
Use the staff scroll bar at the right edge of the work area to scroll through 
the different staves (if you have more than one) in a song. The length of the 
scroll bar from top to bottom represents the order of staves from top to 
bottom. To quickly jump to the staff you want, point to the position you 
want on the scroll bar and click the mouse button. 

Staff Slider 
The staff slider shows you the current vertical position in a song. Use the 
pointer to drag the staff slider to a new position; the current staff number at 
the top of the staff scroll bar changes as you drag to show you the number 
of the current staff. 

Current Staff Number 
The current staff number shows the number of the staff the note pointer is 
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on as you move it through the work area. It also shows the staff slider 
location as you drag the slider. Use the current staff number to jump to the 
f ist  staft Point to the number and click the mouse button. 

Last Staff Number 
The last staff number shows the number of the last staff in the song. Use it 
to see how many staves there are in the song. Use it also to jump to the last 
stafE Point to the number and click the mouse button. 

Block Selectors and Music Blocks 
A single block selector marks a location in a song so you can indicate where 
you want editing actions such as Paste or Merge to start. Use two block 
selectors to define a music block; the section of the song you mark is 
highlighted. A music block defines a section of the song for editing actions 
such as Cut, Copy, or Filter. 

To set a single block selector in a song: 

Point to the top or bottom edge of the work area just above or 
below the column where you want the block selector. A block 
selector (a vertical line) appears on the staff. 

Click the mouse button to leave the block selector in that 
location. 

To remove a single block selector in a song: 

Point to the existing block selector and click the mouse button; 
the existing block selector will disappear. 

To set a second block selector and create a music block: 

Move to the last column you want to include in the marked 
block. Again, point to the top or bottom edge of the work area. 
A second block selector appears on the staff. 

Click the mouse button to mark the end column. The music 
block stretches to cover all of the columns in between the block 
selectors. 

Remove a music block by setting another block selector: The 
block disappears, replaced by a single block selector. 
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Controls 
Pitch Name 

I 

I 
Message 

I 
Time 1 Signature I Area I 

Play Key Note 
Button Signature Value 

Volume Tempo 

Play Button 
Click the Play button to play the entire song. Press the space bar to stop 
playback. You can also press Esc to stop playback. The screen changes to 
display the part of the song where you stopped the playback. 

Message Area 
The message area lists the name of the instrument you are using to enter 
notes in the work area. It also shows the current pitch name and lists the 
number (1 or 2) of the song you are working on. (See the “Switch Song” 
entry in another part of this “Reference” section.) 

Key Signature 
Click the mouse button on the key signature button to transpose, insert, or 
change a new key signature. 

To transpose, change, or insert a key signature: 

Click the mouse button on the key signature button. The key 
signature dialog box appears. 

Select Transpose to move the notes of the music block (or the 
entire song) up to the scale of the new key (you can’t transpose 
down a key). If you don’t select Transpose, the key changes but 
the notes remain at the Same pitch. 

Note: If you do want to transpose down, you can do so by using the pitch 
Range Boxes and the Notes Filter functions in the Set Edit Filter dialog 
box. See the “Set Edit Filter” entry, in this “Reference” Section. 
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Select Insert to insert a new key signature at the left edge of the 
staff. (You can’t insert a key signature in column one.) 

Select Change to change the key signature of the entire score. 

Click the mouse button on OK to complete the key change or 
Cancel to leave the key as it was. 

Time Signature 
The time signature is made of two numbers. The upper number represents 
the number of beats per measure, the lower represents the duration of each 
beat. For example, 4/4 (the most common time signature) means each 
measure has four beats, and each beat is a quarter note. 6/8 means each 
measure has six beats, and each beat is an eighth note. The time signature 
you set determines how the Auto-Insert Measures command places 
measure bars in a song. 

To change the time signature for a whole song: 

Point to the time signature button and click the mouse button. 
The time signature dialog box opens. 

Select the time signature you want, then select OK to change the 
time signature or Cancel to leave the time signature as it is. 

Tempo 
The tempo of a song is the speed at which it plays back. Tempo is meas- 
ured in beats per minute (bpm), from a slow tempo of 56 bpm to a fast 
tempo of 220 bpm. You change tempo by setting the tempo slider in the 
tempo area. The bottom of the tempo area shows the current tempo setting 
and the Italian name for that tempo. (Italian names are traditional music 
markings for tempo.) 

To set the tempo for an entire song: 

Point to the tempo slider, hold down the mouse button, and drag 
the slider to the tempo you want, then release the mouse button. 
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To insert a tempo change in a song: 

Scroll through the song until the section requiring a tempo 
change is at the very left edge of the staff. 

Click the Italian name in the tempo change area. A quarter note 
symbol and the new tempo appear at the left edge of the staff. 

Point to the tempo slider, hold down the mouse button and drag 
the tempo slider to set a new tempo, then release the mouse 
button. The tempo indicator changes to reflect your new tempo 
setting. 

You can only make tempo changes to staff #1 (or the top staff). These 
changes will affect all the staves. 

You can place several tempo settings in a song using these same steps. 
When you play back the song, the tempo changes at each spot where you 
made a tempo setting change. These tempo changes are saved with your 
song. To remove one, select the column it’s in and use the Cut or Clear 
command on the Edit menu. 

Volume 
Drag the sliding control to set the volume of playback from soft @p) to loud 
(ff). The two letters shown in the volume area (the dynamic markings) are 
the traditional music notation for volume. Note that only music played by 
the sound feature or an attached MIDI instrument responds to volume 
settings. All other internal voices ignore volume settings. 

To set the volume for an entire song: 

Point to the volume control, hold down the mouse button, and 
drag the slider to the volume you want, then release the mouse 
button. 

To insert a volume change in a song: 

Scroll through the song until the volume change location is at the 
very left edge of the staff. 
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Click the dynamic marking in the volume change area. The 
marking appears in the song as a new volume indicator, inserted 
at the left edge of the staff. 

Drag the volume slider to set a new volume, then release. The 
dynamic marking in the song changes to reflect your new 
volume setting. 

You can place many volume settings in a song using these Same steps. 
When you play back the song, the volume changes at each spot where the 
volume setting changes. These volume changes are saved with your song. 
To remove them, select the column they’re in and use the Cut command on 
the Edit menu. 

Pitch Name 
The single letter to the right of the key signature button gives the name of 
the pitch location of the note pointer. As you move the pointer up and 
down on the staff, the pitch name changes to show you the pitch of each 
place the pointer indicates. 

Note Value 
The symbol in this box shows you the value of the note you place on the 
staff with the note pointer. 

To select a new note value: 

Point to the note symbol, hold down the mouse button, and 
drag the pointer up or down. The note symbol changes to 
different values. Release the button when you get the note value 
you want. 

To change the note value with the keyboard, press ALT+F9 to 
decrease the value and ALT+F10 to increase the value. 

To place a note on the staff: 

Move the note pointer to the column and pitch you want, then 
click the mouse button. 
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To change the note value without returning to the note value box: 

Move the note pointer to the location on the staff you want, then 
hold down the mouse button and drag the pointer up or down. 
The note value changes; release the mouse button when you get 
the value you want. 

To erase a note on the staff: 

Move the note pointer over the note, and click the mouse button. 

(See the “Notes & Rests Menu” entry later in this “Reference” section for 
another way to change the note values and to learn how to insert and 
manipulate rests.) 

Menus 
The menu bar lists six menus that contain commands and options for The 
Music Studio 3.0. The seventh menu (F10) contains DeskMate accessories 
you can open if you run the full version of DeskMate. The sections that 
follow list and explain the commands and options in each of The Music 
Studio 3.0’s six menus. 

File Menu 
Open the File menu by pressing F2 or by pointing to the word File on the 
menu bar, pressing the mouse button, and dragging down. The commands 
you find here save and open songs to and from disk, save The Music Studio 
3.0 settings, print your song, and quit The Music Studio 3.0 to return to 
DeskMate. 

New 
Choose New to clear all notes, rests, and markings from the work area to 
start a new song. If you choose New when you have notes or other marks in 
the work area that you haven’t saved, a dialog box asks you if you want to 
save the changes in the song. Choose Yes to save the current song before 
clearing the work area. Choose No to clear the current song from the work 
area without saving it. Choose Cancel to go back to the current song 
without clearing it from the work area. 
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Note: The song style (number of staves, instrument setup, note styles, key 
signature, etc.) doesn’t change when you choose New. The song style of 
the new song is the same as the style you set for the old song. To change 
the style for your new song, select Open Style or change it using separate 
steps (see the “Open Style” entry later in this “Reference” section). 

Open Song 
Choose Open Song to load a song from disk. This dialog box appears: 

/ 
\ 

File List 

Open File: J 
C: \TFINIIY 

- Open File Box 
- Pathname 

Open File Box - shows the selected song file. Use it to type in a pathname 
to a new directory or to type in a filename directly. 

Pathname - shows the pathname for the current file directory. 

File List - shows the list of songs available in the current directory. (All 
songs end in the extension .MSS.) 

OK - closes the dialog box and opens the selected song file. 

Cancel - closes the dialog box without loading a new song. 

To open a song file: 

Select the Open Song command from the File menu. The Open 
File dialog box opens and shows you the songs and sub-directo- 
ries available in the current directory. 

Point to the name of the song you want to load and double- 
click the mouse button. Or, select the name of the song, then 
select OK. 

The Load Song Files window closes and the song appears in the work ara. 
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To change the current directory: 

Select the Open Song command from the File menu. The Open 
File dialog box opens. 

To move to a sub-directory, point to the name of the sub- 
directory you want to move to in the file list and double-click the 
mouse button. The file list changes to show the contents of the 
new directory. 

To move to a parent directory, place the cursor in the box to the 
right of Open File, enter two periods (..), and click OK. The 
file list changes to show the contents of the new directory. 

Save Song 
Choose Save Song to once again save a previously saved song to disk. 
When you choose Save Song, the song on the screen is saved to disk with 
the current song filename, and replaces the old version of the song on disk. 

Save Song as 
Choose Save Song as to give a song a new name and save it to disk under 
that name. When you choose Save Song as, the Save File dialog box 
appears. 

Filename Box . 1+ 
- * I  I 

Pathname 

!lmm lmm 
C: \TANDY 

Filename box - shows the current filename of the song (if it has one). 
Use this box to enter a new filename or a new pathname and filename for 
the song. 

Pathname - shows the pathname for the current directory. 

Save - saves the song by the name in the filename box. 

Cancel - closes the dialog box without saving the song. 
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To name (or rename) and save a song: 

Choose Save Song as from the File menu. The Save File dialog 
box opens. 

If the song already has a filename, it appears highlighted in the 
filename box. Press the backspace key or start typing to remove 
the old filename. 

To save the song in the current directory, type in a filename of 
eight characters or less. Use standard DeskMate filename 
conventions. (The Music Studio 3.0 automatically adds an .MSS 
extension to the name, so don't add an extension to the filename 
you enter here.) 

To save the song in another directory, type the full pathname for 
the directory in the filename box followed by the new filename. 

Select OK to close the dialog box and save the song under the 
new name. 

Select Cancel to close the dialog box without changing the name 
of the song or saving the song to disk. 

Open Style 
Choose Open Style to load a style from disk. The Open File dialog box 
appears; it is the same dialog box you use to open a song. 

Point to the name of the style you want to load and double-click 
the mouse button. Or, choose the name of the style then select 
OK. 

Any style you open affects The Music Studio 3.0's working environment. 
The description of the Save Style as command that follows describes the 
contents of a style. 

Save Style as 
Choose Save Style as to save a style to disk. The Save File dialog box 
appears, the same dialog box you use to save a song. Use it to save a style 
just as you used it to save a song. When you save a style to disk, The Music 
Studio 3.0 saves all the current song settings that create the working 
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environment you’re using at the moment. These settings include the song 
setup (including the number and types of staves you have set), instrument 
setup, note styles, filter settings, digitized sound settings, MIDI settings, key 
signature, tempo, time signature, and other settings. 

Use Save Style as to capture a working environment that works well for 
you. For example, you might have one set of MIDI settings, staves, key and 
time signatures, and so on that works well for writing country waltzes. 
Save these settings under a file named COUNTRY so you can recall them at 
any time to start a new country waltz. 

Save Config 
Choose Save Config to save The Music Studio 3.0’s playback settings. 
These settings are the toggle options at the bottom of the Options menu 
that determine which speakers and sound devices play back your songs. 
When you quit The Music Studio 3.0 and open it again later, the settings 
you saved previously with the Save Config command are all in effect as 
default settings. 

Print 
If you have a graphics printer connected to your computer, first choose 
Setup from the F10 menu and make sure the printer is configured correctly. 
Then choose Print to print your song on paper. 

To print a song: 

Make sure your printer is turned on, on-line, and loaded with 
paper before you print. 

Choose Print from the File menu. The song prints on paper. 

Exit 
Choose Exit to close The Music Studio 3.0 and return to DeskMate. If 
you’ve made changes to your song, a dialog box appears asking if you want 
to save your changes. Select Yes to save your changes and quit. Select No 
to quit without saving your changes. Select Cancel to close the dialog box 
and return to The Music Studio 3.0. You can also quit The Music Studio 3.0 
by pressing the Esc key. 
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Run 
Choose Run to close The Music Studio 3.0 and run another DeskMate- 
compatible program without returning to DeskMate. The standard Desk- 
Mate Run dialog box appears where you can enter the program filename 
you want to run. The Music Studio 3.0 will be re-entered after your other 
program is run. (See the DeslcNIate manual for more information on running 
other DeskMate programs.) 

Edit Menu 
Open the Edit menu by pressing F3 or by pointing to the word Edit on the 
menu bar, pressing the mouse button, and dragging down. The commands 
in this menu perform editing functions and switch between songs. 

c u t  
Choose Cut to remove a section of a song and place it in the clipboard. Cut 
removes any music selected by a music block and places the cut section into 
the clipboard. The newly cut section replaces any previous contents of the 
clipboard. Use Paste to retrieve the cut section of music. 

Choose Copy to copy a section of music to the clipboard without removing 
the section from the song. Copy puts a copy of any music selected by a 
music block in the clipboard. The newly copied section replaces any of the 
clipboard’s previous contents. 

Paste 
Choose Paste to insert the contents of the clipboard into a song. If you have 
a music block selected, Paste replaces the contents of the music block with 
the contents of the clipboard. If you have a single block selector in a song 
(instead of a full music block), Paste inserts the contents of the Clipboard at 
the block selector’s location without erasing any music. Paste won’t work 
if you have no block selector set, no music block selected, or an empty 
clipboard. 

Clear 
Choose Clear to remove a section of a song without placing it in the 
clipboard. Clear removes any music selected by a music block. 
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Add Column 
Choose Add Column to insert an empty column into a song. Add Column 
places an empty column at the location of a single block selector or at the 
beginning of a music block. Use Add Column to add empty space to your 
songs much as you use a space bar to add spaces to text in a word process- 
ing program. You can fill the empty columns with notes and rests, or leave 
them blank. 

Add Column has a special feature that lets you enter many columns at 
once: If you select a music block and then choose Add Column, The Music 
Studio 3.0 adds to the score as many new columns as you’ve selected. 

Filter 
Choose Filter to perform a filter edit on a music block. Before you choose 
Filter, use the Set Edit Filters command in the Options menu to set the 
filter options you want to use. These filter options include transposing 
notes, setting note stem directions, changing volume, changing note 
duration, and substituting instruments. ( S e e  the “Set Edit Filters “command 
in the “Options Menu” entry of this “Reference” section for more informa- 
tion.) Once you set filter options and select the block of music you want to 
filter, Filter performs the filter options on the selected music block. 

Merge 
Choose Merge to add the contents of the clipboard to the existing song 
that’s currently displayed. Merge inserts the clipboard music starting at the 
location of a single block selector or at the left edge of a music block, and 
extends as far as necessary to fit the clipboard contents. Use Merge to add 
lines of music from other songs or other parts of a song to existing music. 

Home Song 
Choose Home Song to jump to the beginning of a song. Home Song 
performs the same function as pointing to the current column/measure 
number in the song scroll bar and clicking the mouse button. 

Switch Song 
The Music Studio 3.0 keeps two songs in memory at one time. Choose 
Switch Song to switch from the song you currently see on the screen to the 
second song in memory. 
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If you choose Switch Song when you have opened only one song from disk, 
the second song you see on the screen is displayed as an empty staff. To 
open a second song from disk, choose Open from the File menu. The song 
you open replaces the empty staff on the screen. Use Switch Song to 
switch between the two opened songs stored in memory. 

The Switch Song command makes it easy to cut and paste between the two 
songs in memory. You can use one song for “parts”-musical phrases and 
section+and the other song as the master song. When you use any of the 
File commands such as Save Song, Save Song as, Open Song, or New, the 
commands affect only the song you currently have on the screen. The 
second song remains unaffected. You must use Switch Song to bring the 
other song to the screen before the File commands will work on the song. 
The song number you are working on (either 1 or 2) is displayed in the 
message window at the bottom of the screen. 

Options Menu 
Open the Options menu by pressing F4 or by pointing to the word Options 
on the menu bar, holding down the mouse button, and dragging down. The 
first seven commands in the Options menu provide some of The Music 
Studio 3.0’s most advanced functions: creating and deleting staves, choos- 
ing and creating instruments, setting up MIDI parameters for using an 
external synthesizer, and other functions. The five toggle options that 
follow control the way your computer plays songs, and show locations in 
your songs by columns or measures. 
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Song Setup 
Choose Song Setup to create, modify, or delete staves. The Song Setup 
dialog box appears: 

Display Option 
Clef 

Buttons 

Staff - 
List Box 

h l t 0  
Change Name 
IPiano Tenor I 
rmrsrr - =:I P Staff 

Display 

Title Box - lists the name of the song you're setting up. Select this box by 
pointing to it and clicking the mouse button. Use the keyboard to enter the 
title you want to give your song. 

Note: This title is different from the filename you give your song with 
Save Song as. It doesn't appear in the title bar of the work area screen; it 
only appears on your song when you print it out. 

Staff List Box - lists the staves currently available in the song. Select a 
staff in the box by pointing to its name and clicking the mouse button. Any 
staff changes you make in the rest of the dialog box affect the staff selected 
in this box. 

Change Name Box - lists the currently selected staff. Select this box by 
pointing to it and clicking the mouse button. Use the keyboard to change 
the name of the selected staff. 

Delete - deletes the currently selected staff from the song. 

Add - adds a new staff to the song. You can have up to eight staves in 
a song. 

Display Option - displays the currently selected staff in the work area. 
When this option is turned on, you can see the staff in the work area 
(although you might have to scroll up or down to see it). When this option 
is turned off, the staff doesn't appear on the screen at all, and any notes on 
it are not heard; however, the staff and the notes on it still exist in memory. 
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Clef Buttons - choose the type of clef used on the currently selected staff. 

Staff Display - shows the current staff and clef and the spacing above and 
below the staff. 

Space Above Buttons - set the amount of space above the current staff. 
The Up button moves the space up, the Down button moves the space 
down, and the staff display shows the space as it changes. Use the Space 
Above buttons to control the separation of a staff from the staff immediately 
above it. 

Space Below Buttons - set the amount of space below the current staff. 
The Up button moves the space up, the Down button moves the space 
down, and the staff display shows the space as it changes. Use the Space 
Below buttons to control the separation of a staff from the staff immediately 
below it. 

OK - closes the dialog box and implements the new song setup. 

Cancel - closes the dialog box without implementing the new song setup; 
however, staves added or deleted remain. 

To add a new staff to a song: 

Choose Song Setup to open the Song Setup dialog box. 

Select the Add button. A new staff appears at the top of the staff 
list box. 

Select the Change Name box, delete New Staff, and type in the 
name you want. 

Choose the clef you want to use for the staff by pointing to the 
appropriate clef button and clicking the mouse button. 

Use the Space Above and Space Below buttons to adjust 
spacing. 

Click OK to close the box and see your new staff on the screen. 
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To delete a staff from a song: 

Choose Song Setup to open the Song Setup dialog box. 

Select the staff you want to delete from the staff list box. 

Click the Delete button. A dialog box reminds you that you 
irretrievably lose all the music in the staff when you delete it. 

Click OK to delete the staff. The staff name disappears from the 
staff list box. 

Click OK to close the dialog box and return to the work area. 

About clefs: Each clef determines the position of middle C on the staff 

- The grand staff puts middle C between two staves. 

- The treble clef puts middle C just below a single staff. 

- The bass clef puts middle C just above a single staff. 

- The alto clef puts middle C on the middle line of a single staff. 

- The tenor clef puts middle C on the fourth line up of a 
single staff. 

Select Instrument 
You can use different MIDI patches to play notes in a song that add con- 
trasting voices to the song. Each patch has its own unique characteristics, 
much like acoustic instruments do, and appears visually in a song using 
notes of a texture or color unique to that instrument. The Music Studio 3.0 
allows you to use up to 15 different instruments in a song. Select one of 
these instruments with Select Instrument before you enter notes to make 
those notes play back using that instrument. 
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Choose Select Instrument to select the instrument and its texture or color 
to add notes to a song. The Select Instrument dialog box appears: 

instrument 
List Box 

I 

El. Guitar 
Trombone 
El. Piano 
Bass Guitr 

a 
I 

a a 
a 

a a a a a 
8 a a a 
Q 

I 

Change Name 

(Clarinet 

Display 
Option 

Option 
Change 

-Name 
Box 

Play 

I 
TexturelColor Buttons 

Instrument List Box - lists the instruments you can use to add notes to a 
song. Select an instrument in the box by pointing to it and clicking the 
mouse button. Any instrument changes you make in the rest of the box 
affect this instrument. Each instrument name in the box is accompanied by 
a note texture (or color, if you’re using a color system). When you place 
the notes on the staff, they appear in the texture or color indicated in the 
Select Instrument box. 

TextureKOlor Buttons - choose the texture or color representing an 
instrument on the staff. 

Display Option - displays the notes of an instrument in a song. If this 
option is on, all the selected instrument’s notes appear on a staff. If this 
option is off, the instrument’s notes disappear from the song. The notes still 
exist in memory, and when you turn Display Option on again, the notes 
reappear and can be heard when you play the song. 

Play Option - plays the notes of an instrument in a song. If this option is 
on, all the selected instruments’ notes play. If this option is off, the instru- 
ments’ notes will not play when you play the song. 

Change Name Box - lists the currently selected instrument. Select this box 
and use the keyboard to change the name of the instrument. 



64 Reference 

OK - closes the dialog box and implements the new instrument selection. 

Cancel - closes the dialog box without implementing the new instrument 
selection. 

To select a new instrument: 

Choose Select Instrument to open the Select Instrument 
dialog box. 

Select the instrument you want to use in the Select Instrument 
box by pointing to it and clicking the mouse button. 

If you don’t like the texture or color the instrument uses, point to 
the texture or color button of the texture or color you prefer and 
click the mouse button. The note in the Select Instrument box 
changes to correspond to the new texture or color. 

Choose OK to close the dialog box. 

Add new notes to your song. They appear in the texture or color 
of the new instrument. When you play back the song, the notes 
play back using the instrument you chose. 

-You can also use the speed keys to change instruments without 
going into the Select Instrument dialog box. Number keys 1 
through 9 match instruments 1 through 9. Letter keys A, B, C, 
D, E, and F match instruments 10-15. 

Set Note Style 
A note doesn’t usually sound continuously from its beginning to the 
beginning of the note that follows; it usually stops just before the next note 
starts, which puts some aural “space” between notes. This space separates 
the notes so you can hear them more clearly. The amount of aural space 
between notes determines the style of the notes. 

Choose Set Note Style to control the amount of aural space between notes 
when they play. 
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Note: Note styles only affect notes played through the sound feature of a 
MIDI instrument and only affect notes entered after you’ve made changes 
to the original note style. 

The Set Note Style dialog box appears: 
Current Value Buttons 

Display 

Note Type List Box - lists the different types of notes in a song. Select a 
note type in the box by pointing to it and clicking the mouse button. Any 
note style changes you make in the rest of the box affect this note type. 

Current Value Buttons - change the note playback length of the current 
note type. The left arrow decreases the playback length, the right arrow 
increases it, and the percentage value between them shows the percentage of 
the note’s “normal” duration that actually sounds. 

Note Length Display - shows in graphic form the playback length of each 
note type. The left side of the display represents 0%, the right side repre- 
sents 100%. 

Normal Button - sets the playback length of the selected note to allow a 
small space between each note. 

Staccato Button - sets the playback length of the selected note so each note 
sounds very short. 

Legato Button - sets the playback length of the selected note to 100%. 

OK - closes the dialog box and implements the new note styles. 
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Cancel - closes the dialog box without implementing the new note styles. 

To change a note style: 

Choose Set Note Style to open the Set Note Style dialog box. 

Select a type of note from the note type list box by pointing to it 
and clicking the mouse button. The percentage between the 
Current Value buttons changes to show the playback length of 
the note type. 

Use the left or right Current Value buttons to shorten or 
lengthen the playback length of the note type to a precise value, 
or use the Staccato or Legato buttons to shorten or lengthen the 
playback length to preset values. 

Choose OK to close the dialog box. 

Note that the style you set for a note type affects only newly entered notes. 

Set Edit Filters 
Choose Set Edit Filters to set the filters that work on a block of music. 
Once you set the filters, you must choose Filter from $e Edit menu to 
make them work on the block of music you select. Set Edit Filters opens 
the Set Filters dialog box: 

I t e m  Range Action h o u n t  

W o i e s  1-1 No Change 

Note Stems Up 

_ _  __  - - - 
- ___  _ _ _ 

V o l u m e  -1 No Change xm 
Duration -1 Quant ize 1/32 

Instrument Guitar Change To Clarinet 
lmm= 

Item - lists the names of the filters you set in this dialog box. Each line of 
the dialog box is a different filter that includes a range, action, and amount. 
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Range Boxes - set an instrument or a range of notes by pitch. The filter 
affects only notes or falling within that pitch range. 

Action Boxes - set the type of action a filter takes when it encounters the 
notes or the instrument that fall within the range set in its range box. 

Amount Boxes - set the degree of action the filter takes when it performs an 
action on notes or an instrument. 

OK - closes the dialog box and implements the new filter settings. 

Cancel - closes the dialog box without implementing the new filter settings. 

To set a pitch range: 

Select the appropriate range box and use the keyboard to enter a new range: 
enter a low pitch name and Octave number followed by a dash and a high 
pitch name and Octave number. You must enter three characters for each 
complete pitch specification. 

Enter each pitch name as a capital letter followed by a lower case 
b for flat pitches, a pound sign (#) for sharp pitches, or a space 
for natural pitches. 

Include a number from 0 to 8 at the end of each pitch to specify 
the octave of the pitch. C3 is middle C; octave 0 is three octaves 
below, Octave 8 is five octaves above. Each Octave begins at C 
natural. For example, the range D#2- Ab4 extends from the D 
sharp below middle C to the second A flat above middle C. 

Note that the Instrument Range box doesn’t select a pitch range, but a single 
instrument. Select the instrument in this range box the same way you make 
choices in the Action and Amount boxes (described below). 

To choose actions and amounts in the Action and Amount boxes: 

Point to the Action box and click the mouse button repeatedly. 
Each time you click, the box changes to a new setting; repeated 
clicking cycles through all the settings. Leave the box when you 
have the setting you want. 

Note that the Volume Amount box shows a percentage. To change the 
value there, select the box and use the keyboard. The percentage value 
must be a number from 0 to 100. 
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Notes Filter 
The notes filter looks for any notes in a selected music block that fall within 
the pitch range, and then performs one of four actions on those notes: 

Up - transposes the notes up in pitch by the amount in the 
amount box. 

Down - transposes the notes down in pitch by the amount in the 
amount box. 

Delete - deletes all the notes from the music block 

No Change - leaves all the notes as they are 

The amount of transposition can be 1/2, 1,2,3,4, or 5 steps, or a 
full octave. 

Note Stems Filter 
The note stems filter looks for any notes in a selected music block that 
fall within the pitch range, and then performs one of three actions on 
those notes: 

Up - sets all the note stems up from the note head. 

Down - sets all the note stems down from the note head. 

No Change - leaves all notes stems as they are. 

Volume Filter 
The volume filter looks for any notes in a selected music block that fall 
within the pitch range, and then performs one of four actions on those notes: 

Up - increases the notes’ volumes by the amount set in the 
percentage box 

Down - decreases the notes’ volumes by the amount set in the 
percentage box 

Change To - changes the notes’ volumes to the exact amount set 
in the percentage box 
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No Change - leaves the volumes of all the notes as they are 

Note that each note volume is measured as a value from 0% to 100%. 
When you increase or decrease a volume by the amount in the percentage 
box, you add the amount in the percentage box to the notes’ existing 
volume. For example, increasing a 50% volume by 10% yields a 60% 
volume. 

Duration Filter 
The duration filter, looks for any notes in a selected music block that fall 
within the set range, and then performs one of two actions on those notes: 

Quantize - changes the note durations to the duration set in the 
amount box 

No Change - leaves all the notes as they are 

Use the duration filter to clean up sloppy sounding performances recorded 
with the MIDI Record command. When you quantize music, the filter 
changes note duration. 

The value you set in the amount box (any note value from 1/64 to 1/2) sets 
the beat size: If you choose a very small beat-such as 1/64quantizing only 
moves notes in very small increments so they fall on sixty-fourth note beats. 
If you choose a large beat-such as 1/4 or lbquantizing moves notes in 
large increments and destroys any complex rhythms that take place in less 
than a quarter note’s duration. Choose the value that sounds best. 

Note: It’s recommended that you save a copy of the song before you use 
the Quantize feature. 

Instrument Filter 
The instrument filter looks for any notes in a selected music block that play 
using the instrument selected in the range box, and then performs one of 
three actions on those notes: 

Change To - changes all the notes to play with the instrument set 
in the amount box. 

Delete - deletes all instrument’s notes in the music block 
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Scale Control 

No Change - leaves all the notes as they are 

Use the instrument filter to change instruments on notes already in a song, 
or to get rid of one instrument part entirely. 

Design Sound 
Choose Design Sound to create your own instruments on the Tandy sound 
feature. 

Note: This feature is only available the Tandy lOOOSL or TL if you're using 
a mouse. 

You must select Digitized Sound On in order to choose Design Sound. 
The Edit Wave Data dialog box appears: 

Frequency and Amplitude Modifiers 

Waveform Slider - changes the view of the waveform display to show 
different sections of the current waveform 

Current Sample Number - displays the number of the sample currently on 
view at the left edge of the waveform display 
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Ending Sample Number - displays the number of the sample at the end of 
the waveform table 

Waveform Editing Buttons - perform modifications on the currently 
selected sample block of the waveform table 

Sampling Button - records sampled sounds 

Play Button- plays back sampled sounds 

Scale Control - changes the scale of the waveform display to show the 
entire waveform table at once or to zoom in on one section of the waveform 
table 

Start and End Boxes - set the beginning and end of the sample block, a 
section of the waveform table selected for modification using the Waveform 
Editing buttons 

Freq. and Amplit. Boxes - set the frequency and amplitude of a modifying 
waveform used to change the waveform table with the Waveform Editing 
buttons 

Waveform Modifier Buttons - choose the shape of the modifying 
waveform 

OK - closes the dialog box and implements the waveform table changes 

Load Wave - loads a previously saved digitized sound 

Save Wave - saves to disk the current digitized and edited sound 

Volume - changes playback volume of sample sound. 0 is no volume, 100 
is maximum volume. 

Change Name - lists the currently selected sound. Select this box and use 
the key board to change the name of the sound. 

Sampled Instrument Fundamentals 

Instruments played on the Tandy sound feature are sampled sounds- 
each instrument is a digital recording of a sound captured through a 
microphone and stored in the computer’s memory or on disk as a series of 
numbers describing the sound. This conversion process of sound to stored 
numbers is called sampling, and the series of numbers it creates is called a 
waveform table. 
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When you sample a sound using the Record button in the Edit Wave Data 
dialog box, The Music Studio 3.0 normally reads the input from the micro- 
phone 11,OOO times a second. This is called the sampling rate. The 
numbers it creates when it reads the signals are called samples. 

The waveform table display in the Edit Wave Data dialog box shows in 
graphical form the waveform table of any instrument you load or record. 
The table displays the waveform numbers from left to right, in the order 
they were recorded, therefore the left edge of the waveform table is the 
beginning of the sampled sound, the right edge is the end. There are a 
maximum of 64,OOO samples in a sampled sound instrument, and they’re 
numbered 0 to 64,OOO, from left to right, in the waveform table. 

Note: If you record a standard sound from an instrument, record middle A 
(A above middle C ) .  The Music Studio 3.0 will adjust the frequency value 
for other notes appropriately. 

The Music Studio 3.0 offers waveform editing features. You can modify the 
existing samples by using standard waveforms to modify the sample 
waveform. This process is called modulation . 
A full explanation of sampled sounds and sampled sound editing is beyond 
the scope of this manual. For further explanation of sampled sounds, a 
good place to start is Music Through MIDI by Michael Boom (Microsoft 
Press, 1987). 

To open a sampled sound instrument: 

Choose the Load Wave button to load a new waveform. A 
standard file input dialog box appears. Choose a file containing 
the desired waveform. 

To save a sampled sound instrument: 

When the the waveform is the way you want it, click the Save 
Wave button. A dialog box appears; enter the appropriate 
information. 



Reference 73 

To view the waveform using the scale control: 

Point to the far-right segment of the scale control and click the 
mouse button to see the whole waveform at once in the wave- 
form display. 

Point to any of the left segments of the scale control and click the 
mouse button to zoom in and see a magnified section of the 
waveform. The further left you click, the smaller the section you 
see in the waveform display. 

To change the section on view in the waveform display: 

Point to any section of the waveform slider (between the begin- 
ning and ending sample numbers) and click the mouse button. 
The display jumps to that section of the waveform. Or, point to 
the waveform slider, hold down the mouse button, and drag the 
slider to a new position. As you drag the slider, the current 
sample number changes to show your location at the left edge of 
the waveform display. 

Point to the current sample number and click the mouse button. 
Delete that number and enter a new sample number, 

To select a sample block for editing: 

Enter the beginning sample number of the block in the Start box. 

Enter the ending sample number of the block in the End box. 

To use the editing buttons on a sample block: 

Choose the Delete Block button to delete the block from the 
waveform table. 

Click the Erase Block button to set all the samples in the block 
to 0. (This leaves a flat line at that spot in the waveform.) 

Click the Insert Block button to insert a block of flat line (this 
indicates silence and equals 0 amplitude) into the waveform 
using scale at the location marked in the Start box. 
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Click the Add Block button to add the samples of the selected 
waveform to the samples in the sample block. 

Click the Modulate Block button to multiply the modulation 
waveform against the sampled wave. This is amplitude 
modulation. 

To set a modifying waveform: 

Click one of the three waveform buttons to set a shape: the Sin 
button creates a sine wave, the Sqr button creates a square wave, 
and the Saw button creates a sawtooth wave. 

Set the waveform frequency by typing a value in the Freq. box. 
("'he frequency is measured in cycles per second.) 

Set the waveform percent amplitude by typing a value from 0 to 
100 in the Amplit. box. (0 is no amplitude, 100 is maximum 
amplitude.) 

To record a sampled sound: 

Make sure the microphone (or other sound source) is connected 
to the Tandy sound feature as described in the Tandy manual. 

Click the Record button to start sampling. When the waveform 
display is filled, the sampled sound is finished recording. You 
can look at the waveform display or listen to the sound by 
playing it back. If you don't like the sound, repeat the recording 
procedure to replace the waveform with a new one. 

Playing back a sampled sound: 

Set the playback volume by entering a number from 0 to 100 in 
the Output Volume box. (0 is silent, 100 is maximum volume.) 

Click the Play button to play back the sound. 
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MIDI Settings 
Choose MIDI Settings to set up The Music Studio 3.0 to play back songs 
over one or more attached MIDI instruments. MIDI instruments must be 
attached using either a Roland MPU-401 (or a compatible) MIDI interface, 
VoyetraTM OP-4001, or the Mellotron MUART. The MIDI Settings dialog 
box appears: 

Pla Option 
Jutton 

Accordinn 
E l .  Guitar 

B a s s  Cuitr 

I 

[Guitar Ell B l o c k  Staff _, 
1 - 1  

. . . . . . ....... . . . . ..... .. . . ... .. . A Icm;RuI 

Instrirnent C han ne1 Preset Voiume Playback 
List Box Settings Settings Settings Buttons 

Instrument List Box - lists the instruments you can use to enter notes in 
a song 

Channel Box - sets the MIDI channel over which the notes of the selected 
instrument play 

Preset Box - sets the preset on the attached MIDI instrument that plays the 
notes of the selected instrument 

Volume Box - sets the volume the attached MIDI instrument uses to play 
back the notes of the selected instrument 

Channel Settings - display the channel setting for each instrument 

Preset Settings - display the preset setting for each instrument 

Volume Settings - display the volume setting for each instrument 
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Display Option - displays the notes of an instrument in a song. If this 
option is on, all the selected instrument’s notes appear on a staff. If this 
option is off, the instrument’s notes disappear from the song. The notes still 
exist in memory, and when you turn Display Option on again, the notes 
reappear and can be heard when you play the song. 

Play Option Button - turn MIDI playback on and off for the selected 
instrument 

Change Name Box - changes the name of any instrument you select 

Playback Buttons - allow you to play back the entire song, the contents of 
the clipboard, the currently selected music block, or the currently selected 
staff without leaving this dialog box 

All To Current Button - sets the MIDI settings of every instrument in the 
list to the settings of the currently selected instrument 

OK - closes the dialog box and implements the new MIDI settings 

Cancel - closes the dialog box without implementing the new MIDI settings 

MIDI Fundamentals 
The Music Studio 3.0 plays songs on attached MIDI instruments by sending 
MIDI messages through the MIDI interface card and over the MIDI cables 
to the receiving MIDI instrument. If you have several MIDI instruments 
attached to your computer (or a synthesizer that splits into several different 
instruments), you may be able to set each instrument to receive MIDI 
messages on a different MIDI channel (numbered from 1 to 16). By 
sending messages on one channel, you send them only to the instruments 
that receive that channel. 

If apreset number message precedes the MIDI messages that play notes, the 
preset number asks the MIDI instrument to select a preset (the same as a 
patch, instrument, or voice-terminology differs from instrument to 
instrument) before it plays. The preset controls the sound of the instrument. 
For example, if The Music Studio 3.0 asks for preset number 12 
before it plays notes over MIDI, the receiving instrument turns on its 
number 12 preset, which may be something like Electric Kazoo (or another 
sound). The instrument then plays the notes it receives sounding like an 
electric kazoo. 
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MIDI messages also control the volume of the notes they play by assigning 
them a loudness from 0 (silent) to 127 (full volume). The Music Studio 3.0 
usually assigns MIDI volumes to the notes it plays by following the 
volumes you set while creating the song. You can override those volumes, 
however, if you set a new volume setting in the MIDI Settings dialog box. 

A full discussion of MIDI is beyond the scope of this manual; for further 
reading, start with Music Through MIDI by Michael Boom (Microsoft 
Press, 1987). You should also take time to read through the manual that 
came with your MIDI instrument to learn its particular MIDI quirks and 
capabilities. 

To assign an instrument from The Music Shrdio 3.0 to play on a MIDI 
instrument: 

Choose MIDI Settings from the Options menu to open the 
MIDI Settings dialog box. 

Select an instrument from the instrument list box by pointing to 
it and clicking the mouse button. 

Select the Channel box and enter the channel number (1 to 16) 
of the MIDI instrument you want to play. (1 is the standard 
channel used by most MIDI instruments.) 

Select the Preset box and enter the number of the preset you 
want to play. 

If you want to override the volumes you entered in the song, type 
a volume value of 0 or 2 (very low) to 100 (full blast) percent in 
the Volume box. Note that this volume plays steadily for the 
instrument throughout the song, overriding any volume changes 
you may have entered. If you enter S, the song’s own volumes 
play over MIDI without interference. If you enter V, the volume 
slider will override the song’s own volume. Note also that if you 
record a song using MIDI Record, any volume setting here will 
not override the volumes you recorded. 

Click Play Option if you want to affect whether or not the 
instrument sounds. 

If you want to change the name of the instrument, select the 
Change Name box and enter a new name. 
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Select any other instruments you want to play via MIDI and 
change their settings to your satisfaction. 

Test your MIDI settings by clicking the Play button. The entire 
song plays back. To play back the contents of the clipboard, the 
currently selected music block, or the currently selected staff, 
first click the Clip, Block, or Staff button, then click Play. 

Click OK to close the box and return to the work area; the new 
MIDI settings will be in effect. 

MIDI Record 
Choose MIDI Record to record your performance on an attached MIDI 
instrument as a song. The MIDI Record dialog box appears: 

netronone 

Quantize 0 -- 
I 

Recording Size 

Metronome - turns a clicking metronome on and off. The metronome 
plays at the tempo set by the tempo slider in the work area. 

Start Record - starts and stops the MIDI recording. 

Quantize - when checked, aligns or “rounds off” your actual MIDI input 
to the nearest thirty-second note. 

Recording Size - tells, in columns, how large the recording is. 

Erase - erases the last song section you recorded with the Start Record 
button. 

OK - closes the dialog box and shows you the song you recorded in the 
work area. 
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Cancel - closes the dialog box without putting your recording in the work 
area. All recording you made while the dialog box was open is erased. 

MIDI Recording Fundamentals 
When you use MIDI Record, you store incoming MIDI messages on any 
MIDI channel coming from an attached MIDI instrument, including Note- 
on, Note-off, Frequency, Preset, and velocity. These messages carry 
information about note pitches and durations. If your MIDI instrument has 
a velocity-sensitive keyboard (or any other mechanism that creates notes of 
different volumes), MIDI Record also stores MIDI messages that carry 
information about note volumes, which may change from note to note while 
you play. 

When you first open the MIDI Record dialog box, nothing is recorded. The 
first time you use the Start Record button to record a performance, the 
notes you play are stored in memory. Each time you use Start Record 
afterward to record more music, the notes you record are appended to the 
previous recordings stored in memory. Use this feature to record songs in 
segments so you don’t have to perform the whole song in one take. If you 
record a segment you don’t like, use the Erase button-it erases the last 
segment you recorded without erasing the whole recording. 

When you click OK to close the dialog box and return to the work area, 
MIDI Record appends any music you recorded to the end of the song 
currently on the screen. To turn the recording into notes, MIDI Record 
uses the metronome beat as a measuring device to tell how far apart the 
notes are. Each metronome beat represents a quarter note as a full beat. If 
you’re using just the metronome, you’ll find that this translation is often too 
exact; less-than-precise playing on your part creates many thirty-second 
notes and other small notes. To clean this up, use the Quantize feature in 
the MIDI Record dialog box. 

To make a MIDI recording: 

Make sure your MIDI instrument is attached via MIDI cables 
and a MIDI adaptor card, and the instrument is turned on. 

Set the tempo slider in the work area to the tempo of the beat 
you want to use when recording your song. 

Choose MIDI Record from the Options menu to open the MIDI 
Record dialog box. 
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Turn the Metronome on or off, as you prefer. 

Turn Quantize on or off, as you prefer. 

Select Start Record to start recording, then play the music you 
want recorded. 

Press the space bar to stop recording when you’ve finished 
playing. 

Use Start and Stop Record to record additional segments of the 
song if you wish. 

If you make a mistake while playing a song segment, click the 
mouse button on Erase as soon as you stop recording. The 
segment just recorded disappears from memory and you can 
record it over again. 

Choose OK to close the dtalog box and return to the work area; 
there you can look at and edit your recording. 

Toggle Options 
The five toggle options at the bottom of the Options menu turn on and off 
when you select them. The first time you select a toggle option, you turn it 
on and a check mark appears before it in the menu to show it’s selected. 
The second time you select the option, you turn it off and the check mark 
disappears. 

The first two options, Number Measures and Note Sound Off, are 
independent of the other options. 

The last three toggle options control the sound used to play back songs. 
The three types of playback are: 

Internal Sound Off - a single voice is built into almost all computers. 
This is the simplest form of playback-it doesn’t respond to instrument or 
volume changes. There are three voices built into the Tandy 1000 series of 
computers. The voices are similar to the internal speaker, but since there 
are three of them, they can play three different parts in a song. 

Note: With the Tandy voices, you can’t hear below A1 or above G#7, 
though the note may be displayed on the screen. With the internal speaker, 
you can’t hear below CO or above B6. 
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Digitized Sound Off (or sound card) - up to three voices from sampled 
sound are built into the Tandy lo00 L series of computers and can be loaded 
into Select Instrument as the first three instruments. (See the “Design 
Sound” entry earlier in this “Reference” section for instructions on how to 
load these voices.) This form of playback responds to volume and uses the 
distinctive sound of the instruments you load with Design Sound. You 
can’t hear below El or above A5, though the notes may be displayed on the 
screen. 

Note: This feature is only available on the Tandy lOOOSL or TL if you’re 
using a mouse. 

MIDI Off - as many and as varied voices as you have available in your 
attached MIDI instruments. With the right equipment, MIDI can play back 
the full 15 notes at a time. 

If the Digitized Sound feature is selected, the other output options 
are turned off. The MIDI and Internal Sound features can be on 
simultaneously. 

Number Measures 
Choose Number Measures to tum on and off the Number Measures option. 
When it’s on, the current column/measure number on the left edge of the 
song scroll bar changes to show the song location as a measure number 
instead of a column number, and the last column/measure number on the 
right edge of the scroll bar changes to show the length of the song in 
measures instead of columns. When this option is off, both numbers show 
columns instead of measures. 

Note: If Number Measures is on when New is selected, the current 
and last column/measure numbers display 1 until Auto-Insert Measures 
is selected. 

Note Sound Off 
Choose Note Sound Off to turn off and on the sound that plays as you 
move the note cursor around a staff in the work area. When the Note Sound 
is on, you hear the pitch of the note cursor’s location on a staff as you move 
the cursor up and down. When it’s off, no sound plays as you move the 
note cursor. 
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Internal Sound Off 
Choose Internal Sound Off to turn off and on the playback of the single- 
voiced internal sound, or the three voice Tandy sound if you have that 
feature. 

Digitized Sound Off 
Choose Digitized Sound Off to turn off and on the playback of the digit- 
ized sound feature and the sound feature plug-in card (if you have one). 

Note: This feature is only available on the Tandy lOOOSL or TL if you’re 
using a mouse. 

MIDI Off 
Choose MIDI Off to turn off and on the playback of any attached MIDI 
instruments. 

Notation Menu 
Open the Notation menu by pressing F5 or by pointing to the word Nota- 
tion on the menu bar, holding down the mouse button, and dragging down. 
The commands in this menu work on a music block to add volume increases 
and decreases, repeats, measure bars, beamed note flags, ties, and slurs. 

CrescendolDiminuendo 
Choose Crescendo/Diminuendo to gradually raise (crescendo) or lower 
(diminuendo) the volume over the length of a music block. It opens the 
CrescendoDiminuendo dialog box: 

Start Uo 1 ume End Volume 

Note: If you have the Internal Sound option only and not the Digitized 
Sound or MIDI, you won’t be able to hear a crescendo/diminuendo on 
playback. 
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Start Volume Box - sets the starting volume of the volume change as a 
value from 1% (silence) to 100% (full volume) 

End Volume Box - sets the ending volume of the volume change as a value 
from 1% to 100% 

OK - closes the dialog box and implements the crescendo or diminuendo 
you set over the marked block of notes 

Cancel - closes the dialog box without implementing any crescendo 
or diminuendo 

To add a crescendo or diminuendo to a section of music: 

Select the section of music as a music block (you can select up to 
16 columns). 

Choose CrescenddDiminuendo to open the Crescendo/ 
Diminuendo dialog box. 

Enter the volume value you want to start from in the Start 
Volume box. 

Enter the volume value you want to end with in the End 
Volume box. For a cresendo, the end volume should be larger 
than the start volume. For a diminuendo, the end volume should 
be smaller than the start volume. 

Click OK to close the dialog box and insert the crescendo or 
diminuendo. A crescendo or diminuendo mark appears within 
the section of music. 

Add Repeat 
Choose Add Repeat to repeat a music block during playback. When you 
select a music block and choose Add Repeat, it opens the Set Repeat Count 
dialog box. Enter the number of times you want the block to repeat in the 
text box, then click OK to close the box. Repeat signs appear at the 
beginning and end of the music block. The first repeat sign shows how 
many times the block repeats during playback. If you don’t mark a block, 
the entire song will be treated as a marked block. 

To delete a repeat, mark a block containing exactly the repeat you wish to 
remove. Choose Add Repeat and set the Repeat Count to 1. Click OK to 
remove the repeat. 



84 Reference 

Auto-Insert Measures 
Choose Auto-Insert Measures to add measure bars throughout a score. 
Thiscommand reads the current time signature to see what note value is a 
beat and how many beats there are per measure. It inserts bar lines at the ap- 
propriate locations throughout the rest of the song. If there are measure bars 
already in place in the song, Auto-Insert Measures removes and replaces 
them if they aren’t in the correct location for the time signature. 

Insert Measure Bar 
Choose Insert Measure Bar to insert a single measure bar line at the location 
of a single block marker or at the left edge of a music block. 

Beam 
Choose Beam to beam together the note flags of notes within a music block. 
If you choose Beam for a music block that already contains beamed notes, 
it removes all beams from the note flags. 

Note: You can beam only one note per column, regardless of what staff the 
note is in. 

Tie 
Choose Tie to tie together notes within a music block. Only consecutive 
notes of the same pitch tie together. Notes tied together sound as one long 
note (the combined value of the tied notes) during playback. If you choose 
Tie for a music block that already contains tied notes, it removes all ties. 

Slur 
Choose Slur to slur together notes within a music block. Unlike Tie, Slur 
groups consecutive notes together that aren’t of the same pitch. If you 
choose Slur for a music block that already contains slurred notes, it 
removes all slurs. 

Notes & Rests Menu 
Open the Notes & Rests menu by pressing F6 or by pointing to the words 
Notes & Rests on the menu bar, pressing the mouse button, and dragging 
down. The commands in this menu control the types of notes and rests you 
enter in the work area with the note pointer. (See the “Grand Staff” section 
earlier in this “Reference” section.) 
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NOTE -> Rest (Note <-REST) 
Choose NOTE --> Rest to insert rests in a song. The symbol in the note 
value box of the work area turns into a rest, and the note pointer turns into a 
rest pointer. Any time you point and click the mouse button on a staff in the 
work area, a rest appears. As long as the rest symbol is in the note value 
box, this command reads Note <-REST in the menu. 

Choose Note e- REST to change the rest pointer back to a note pointer so 
you can insert notes. 

Note: If you’re using the acceleration key, use the lower case x to perform 
the same function. 

Flip Note 
Choose Flip Note to change the direction of the note stem before you place 
a note. The note in the note value box changes to point either up or down. 
You can also press the space bar to perform the same function. If you’re 
placing notes for two instruments on the same staff, flipping the notes for 
one of the instruments makes that line of music easier to read. 

Triplet 
Choose Triplet to change the notes and rests you insert into triplet notes 
and rests. The note or rest in the note value box changes to show a small 
three (the triplet sign) beside it, and all notes and rests you insert also show 
the triplet sign. A triplet note lasts two-thirds the length of a non-triplet 
note. Three triplet notes last as long as two regular notes of the same value, 
hence the name triplets. For example, three triplet quarter notes last as long 
as two regular quarter notes. 

Notes and rests can’t be triplet and dotted at the same time. 

Dotted 
Choose Dotted to change the notes and rests you insert into dotted notes 
and rests. The note or rest in the note value box changes to show a dot 
beside it, and all notes and rests you insert also show the dot. A dotted note 
lasts one half again as long as a regular note of the same value. 

Notes and rests can’t be dotted and mplet at the same time. 
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Accent 
Choose Accent to change the notes you insert into accented notes that play 
at full volume and stand out from notes of lesser volume surrounding them. 
The note in the note value box changes to show an accent mark by it, and all 
notes you insert also show the accent mark. 

Notes can’t be accented and staccato at the same time. 

Note: This command is for notation purposes only. Actual note duration 
control is available in the Options menu under Set Note Style. S e e  the “Set 
Note Style” entry in this “Reference” section. 

Staccato 
Choose Staccato to change the notes you insert into staccato notes that play 
in a very short note style. The note in the note value box changes to show a 
staccato mark by it, and all notes you insert also show the staccato mark. 

Notes can’t be staccato and accented at the same time. 

Note: This command is for notation purposes only. Actual note duration 
control is available in the Options menu under Set Note Style. S e e  the “Set 
Note Style” entry in this “Reference” section. 

Use Key 
Choose Use Key to turn the key signature note option on. (A check appears 
before this option in the menu while it’s on.) While the key signature note 
option is on, any notes you enter in the staff are sharp, flat, or natural 
according to the key signature-no sharp, flat, or natural sign appears 
before the note. Choosing this option turns off the Natural, Sharp, or Flat 
options. 

Natural 
Choose Natural to turn the natural note option on. (A check appears before 
this option in the menu while it’s on, and a natural sign appears before the 
note in the note value box.) While the natural note option is on, any notes 
you enter in the staff are natural regardless of the key signature-a natural 
sign appears before the note. Choosing this option turns off the Use Key, 
Sharp, or Flat options. 



Reference 87 

Sharp 
Choose Sharp to turn the sharp note option on. (A check appears before 
this option in the menu while it’s on, and a sharp sign appears before the 
note in the note value box.) While the sharp note option is on, any notes 
you enter in the staff are sharp regardless of the key signature-a sharp sign 
appears before the note. Choosing this option turns off the Use Key, 
Natural, or Flat options. 

Flat 
Choose Flat to turn the flat note option on. (A check appears before this 
option in the menu while it’s on, and a flat sign appears before the note in 
the note value box.) While the flat note option is on, any notes you enter in 
the staff are flat regardless of the key signature-a flat sign appears before 
the note. Choosing this option turns off the Use Key, Natural, or Sharp 
options. 

Goodies Menu 
Open the Goodies menu by pressing F7 or by pointing to the word Goodies 
on the menu bar, pressing the mouse button, and dragging down. The 
commands in this menu perform many of the same functions as the controls 
in the work area. This menu also offers a convenient place to see the 
keyboard accelerators for control functions. 

Play Entire Song 
Choose Play Entire Song to play the current song from beginning to end. 
This has the same effect as clicking the Play button in the work area. Press 
the space bar to stop playback before the end. 

Play Current Staff 
Choose Play Current Staff to play only the music in the staff currently 
selected in the work area without playing music in any of the other staves of 
the song. Press the space bar to stop playback before the end. 

Play Marked Block 
Choose Play Marked Block to play the contents of a music block without 
playing any of the rest of the song. Press the space bar to stop playback 
before the end. 
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Play Clipboard 
Choose Play Clipboard to play the contents of the clipboard. Press the 
space bar to stop playback before the end. 

Key Signature 
Choose Key Signature to insert a key signature in the song. This has the 
same effect as clicking the key signature control in the work area. It opens 
the Key Signature dialog box. See the “Key Signature” entry under the 
“Controls” description earlier in this “Reference” section for more informa- 
tion about setting the time signature. 

Time Signature 
Choose Time Signature to change the time signature for the song. This has 
the same effect as clicking the time signature control in the work area. It 
opens the Time Signature dialog box. See the “Time Signature” entry under 
the “Controls” description earlier in this “Reference” section for more in- 
formation about setting the time signature. 

Insert Tempo 
Choose Insert Tempo to change a tempo within a song. This has the same 
effect as clicking the Italian name box in the tempo change area of the work 
area. It inserts the current tempo setting into the song. See the “Tempo” 
entry under the “Controls” description earlier in this “Reference” section 
for more information about setting the time signature. 

Insert Volume 
Choose Insert Volume to change the volume level within a song. This has 
the same effect as clicking on the dynamic marking box in the volume 
change area of the work area. It inserts the current volume setting into the 
song. See the “Volume” entry under the “Controls” description earlier in 
this “Reference” section for more information about setting the time 
signature. This option works only on Digitized and MIDI sounds; it doesn’t 
work on Internal Sound. 

Available Memory 
Choose Available Memory to see how much memory you have left to use 
for entering additional notes and using other The Music Studio 3.0 func- 
tions. A dialog box opens that shows you the number of bytes of free 
memory. Click OK to close the box. 
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Index 
accent, 86 
accidentals, 86-87 
Action boxes, 66,67-69 
Add Block, 70,74 
Add Column, 58 
Add Repeat, 83 
Add Staff, 60,61 
adding notes, see: entering notes 
All to Current button, 76 
alto clef, 62 
Amount boxes, 66,67-69 
Auto-Insert Measures, 26 
Available Memory, 88 

bass clef, 62 
Beam, 84 
beats per minute (bpm), 49 
block, music see: music block 
block selector, 25,47 

change directory, 54 
change key signature, 48,88 
Change Name box, 60,63,75,77 
change note duration, 65 
change note stem direction, 68,85, 
change note value, 26-27,51-52 
change pitch, 51,67 
change tempo, 22,49,88 
change time signature, 49,88 
change volume, 50-51,88 
changing instruments, 31-34 
changing current &rectory, 54 
Channel Box, 75 
Channel Settings, 75 
Clear, 57 
Clef buttons, 60,61 
Clipboard, 26,87 
column, 23-24 
composing a song, 26-30 

controls, 17, 19 

copying notes, 26,57 
copying 

COPY, 57 

music block, 26 
original disks, 10 
to floppy disks, 1 1 
to a hard disk, 12-13 

CrescendoIDiminuendo, 82-83 
current columrdmeasure number, 

Current Sample Number, 70,71 
current staff number, 46-47 
Current Value buttons, 65 
Cut, 57 

45-46 

deleting notes, 24,52 
deleting staves, 62 
Delete Block, 70,73 
Design Sound, 70-74, 
Digitized Sound, 81,82 
diminuendo, see: Crescendo/ 

Diminuendo 
Display Option, 60,63,76, 
Dotted notes, 28,85 
duration filter, 69 
dynamic markings, see: Volume 

Edit, 57 
edit filters, see: Set Edit Filters 
Edit Wave Data, 70 
editing, 26 
End Volume Box, 82,83 
Ending Sample Number, 71 
entering notes, 23-24,44,51,84-85 
entering rests, 84-85 
Erase, 78 
erase notes, 52 
Erase Block, 70,73 
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Exit, 56 
File List, 53 
File menu, 52 
Filename box, 54 
Filter, 58 
Flat, 87 
Flip note, 85 
floppy disks, 11,14 
Freq. and Amplit. Boxes, 70.71 
“Frere Jacques,” 23 

Goodies Menu, 87 
grand staff, 18,62 

hard disk drive, 14- 15 
hardware, 9 
Home Song, 58 

Insert Block, 70,73 
Insert Column, see: Add Column 
insert key signature, 48-49 
Insert Measure Bar, 84 
Insert Tempo, 88 
Insert Volume, 88 
instrument filter, 69 
instrument list box, 32, 63,75 
Internal Sound off, 80,82 

joy stick, 5,7,18 

key change, 48, 
Key Signature, 48 

last staff number, 47 
last column/measure number, 46 
Legato button, 65 
Load Wave, 70,71 
lower staff, 18 

Menus, 52 
Merge, 58 
message area, 17,43 
Metronome, 36,78 
MIDI connections, 3 1 
MIDI fundamentals, 76-78 
MIDI instruments, 31-32 
MIDI Off, 8 1,82 
MIDI playback, 35 
MIDI Record, 36-37,78-80 
MIDI recording fundamentals, 79-80 
MIDI Settings, 34-35,36,75 
modifying waveform, 74 
Modulate Block, 70,74 
mouse actions, 5,7, 18 
music block, 25,26,47 

naming a song, 29-30,54-55 
Natural, 86 
New, 23,52-53 
Normal button, 65 
Notation Menu, 82 
Note Length Display, 65 
note pointer, 23-24 

Note <- REST, 85 
Note Sound Off, 23,81 
Note Stems filter, 68 
Note Type List box, 65 
note value, 19,51 
Notes & Rests Menu, 84 
Notes filter, 68 
notes 

NOTE -> Rest, 85 

changing, 24 
copying, 26,57 

deleting, 24 
placing, 18,23-24,44,51 

Number Measures, 8 1 

dotted, 28-29 

measure, 26 
menu bar, 17,43 octave, 67 
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Open File box, 53 
Open Song, 21-22,53 
Open Style, 55 
opening a sampled sound 

instrument, 72 
opening a song, 2 1-22 
Options Menu, 59 

Paste, 26,57 
Pathname, 53,54 
Pitch name, 18, 51 
pitch range, 67 
placing notes, 18,23-24 
Play button, 22,48,87 
play entire song, 22,48,87 
Play Current Staff, 87 
Play Marked Block, 87 
Play Clipboard, 88 
Preset box, 75 
Preset settings, 75 
Print, 56 

Quantize, 36,69,78, 
quit, see: Exit 

Range boxes, 67 
record, see: MIDI Record 
rests, 85 
repeat, 83 

sampled sound instrument, 72 
sampled sound, 72-74 
sampling button, 71 
sampling, 72-74 
Save Config, 56 
Save Song, 29, 54 
Save Song as, 54,55 
Save Style as, 55-56 
Save Wave, 7 1,72 
saving songs, 29-30 
scale control, 71 

screen, 17,43 
scroll handles, 45 
scrolling through a song, 45 
Select Instrument, 62-64 
selecting a music block, 25,47 
Set Edit Filters, 66-70 
Set Note Style, 64-66 
Sharp, 87 
Slur, 84 
software,l0 
song scroll bar, 45 
Song Setup, 60-62 
song slider, 45 
Space Above buttons, 61 
Space Below buttons, 61 
speed keys, 34 
Staccato, 86 
Staccato button, 65 
staff (staves), 62 
Staff Display, 61 
Staff List box, 60 
staff scroll bar, 46 
staff slider, 46 
Start and End boxes, 7 1 
Start Record, 36,78 
Start Volume box, 83 
Switch Song, 58 I 

tempo, 22,49 
tenor clef, 62 
texture/color buttons, 63 
Tie, 84 
time signature, 49 
title bar, 17,43 
Title box, 60 
Toggle Options, 80-82 
transpose, 48.67, 
treble clef, 62 
Triplet, 85 

upper staff, 18 
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Use Key, 86 

value, see: note value 
Volume, 7 1 
Volume Amount box, 67 
Volume filter, 68-69 
Volume settings, 75 

Waveform buttons, 71 
Waveform display, 70,73 
Waveform Editing buttons, 71 
waveform scale, 73 
Waveform slider, 70 
work area, 18,44 



ACTIVISION LIMITED 90-DAY WARRANTY 

Activision warrants to the original consumer purchaser of this computer software product that 
the recording medium on which the software programs are recorded will be free from defects 
in material and workmanship for 90 days from the date of purchase. If the recording medium 
is found defective within 90 days of original purchase, Activision agrees to replace, free of 
charge, any product discovered to be defective within such period upon receipt at its FactoIy 
Service Center of the product. postage paid, with proof of date of purchase. 

This warranty is limited to the recording medium containing the software program originally 
provided by Activision and is not applicable to normal wear and tear. This warranty shall not 
be applicable and shall be void if the defect has arisen through abuse, mistreatment, or 
neglect. Any implied warranties applicable to this product are limited to the 90-day period 
described above. If the recording medium should fail after the original 90-day warranty 
period has expired, you may return the software program to Activision at the address noted 
below with a check or money order for $10.00 (U.S. currency), which includes postage and 
handling, and Activision will mail a replacement to you. To receive a replacement, you 
should enclose the defective medium (including the original product label) in protective 
packaging accompanied by: (1) a $10.00 check or money order, (2) a brief statement 
describing the defect, and (3) your return address. EXCEPT AS SET FORTH ABOVE, THIS 
WARRANTY IS IN LIEU OF ALL OTHER WARRANTIES, WHETHER ORAL OR 

CHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE, AND NO OTHER 
REPRESENTATION OR CLAIMS OF ANY NATURE SHALL BE BINDING ON OR 
OBLIGATE ACTIVISION . IN NO EVENT WILL ACTIVISION BE LIABLE FOR 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGE RESULTING FROM POS- 
SESSION, USE, OR MALFUNCTION OF THIS PRODUCT, INCLUDING DAMAGE TO 
PROPERTY AND, TO THE EXTENT PERMI'lTED BY LAW, DAMAGES FOR 

lTY OF SUCH DAMAGES. 

wRI?TEN, EXPRESS OR IMPLIED, INCLUDING ANY WARRANTY OF MER- 

PERSONAL INJURY, EVEN IF ACTIVISION HAS BEEN ADVISED OF THE POSSIBIL- 

SOME STATES DO NOT ALLOW LIMITATIONS ON HOW LONG AN IMPLIED 
WARRANTY LASTS AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL 
OR CONSEQUENTIAL DAMAGES, SO THE ABOVE LIMITATIONS AND/OR EXCLU- 
SION OR LIMITATION OF LIABILITY MAY NOT APPLY TO YOU. THIS WAR- 
RANTY GIVES YOU SPECIFIC LEGAL RIGHTS, AND YOU MAY HAVE OTHER 
RIGHTS WHICH VARY FROM STATE TO STATE. 

RETURNS 

Registered mail is recommended for returns. For the best service, please be sure to: 

1. 
2. 

3. 

Send the diskettes and sales receipt. 
Write the name of the product and the type of computer system you 
have on the front of the package. 
Enclose your return address, typed or printed clearly, insidc the 
package. 

Send to: 
WARRANTY REPLACEMENTS 

Activision 
P.O. Box 3047 

Menlo Park, CA 94025-3047 
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